
Tacheometry 

 

Introduction 

It is a method of surveying in which horizontal distances and (relative) vertical elevations are 

determined from subtended intervals and vertical angles observed with an instrument. 

Uses of Tacheometry 

Tacheometry is used for 

1. preparation of topographic map where both horizontal and vertical distances are 
required to be measured; 

2. survey work in difficult terrain where direct methods of measurements are inconvenient; 
3. reconnaissance survey for highways and railways etc; 

4. establishment of secondary control points. 

Instrument 

The instruments employed in tacheometry are the engineer's transit and the leveling rod or 
stadia rod, the theodolite and the subtense bar, the self-reducing theodolite and the leveling 
rod, the distance wedge and the horizontal distance rod, and the reduction tacheometer and 

the horizontal distance rod. 

Systems of Tachometric Measurement 

Depending on the type of instrument and methods/types of observations, tacheometric measurement systems 
can be divided into two basic types: 

(i) Stadia systems and        (ii) Non-stadia systems 

 

Stadia Systems 

In there system's, staff intercepts at a pair of stadia hairs present at diaphragm, are considered. The stadia 
system consists of two methods: 

 Fixed-hair method and 

 Movable-hair method 

Fixed - Hair method 

In this method, stadia hairs are kept at fixed interval and the staff interval or intercept (corresponding to the 
stadia hairs) on the leveling staff varies. Staff intercept depends upon the distance between the instrument 
station and the staff. 

Movable - Hair method 

In this method, the staff interval is kept constant by changing the distance between the stadia hairs. Targets 
on the staff are fixed at a known interval and the stadia hairs are adjusted to bisect the upper target at the 
upper hair and the lower target at the lower hair. Instruments used in this method are required to have 
provision for the measurement of the variable interval between the stadia hairs. As it is inconvenient to 
measure the stadia interval accurately, the movable hair method is rarely used. 
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Non - stadia systems 

This method of surveying is primarily based on principles of trigonometry and thus telescopes without stadia 
diaphragm are used. This system comprises of two methods: 

(i) Tangential method  and  (ii) Subtense bar method. 

 
 

Fixed-hair method or Stadia method 

It is the most prevalent method for tacheometric surveying. In this method, the telescope of the theodolite is 
equipped with two additional cross hairs, one above and the other below the main horizontal hair at equal 
distance. These additional cross hairs are known as stadia hairs. This is also known as tacheometer. 

Principle of Stadia method 

(Figure 23.1) A tacheometer is temporarily adjusted on the station P with horizontal line of sight. Let a and b 
be the lower and the upper stadia hairs of the instrument and their actual vertical separation be designated as 
i. Let f be the focal length of the objective lens of the tacheometer and c be horizontal distance between the 
optical centre of the objective lens and the vertical axis of the instrument. Let the objective lens is focused to a 
staff held vertically at Q, say at horizontal distance D from the instrument station. 

By the laws of optics, the images of readings at A and B of the staff will appear along the stadia hairs at a and 
b respectively. Let the staff interval i.e., the difference between the readings at A and B be designated by s. 
Similar triangle between the object and image will form with vertex at the focus of the objective lens (F). Let 

the horizontal distance of the staff from F be d. Then, from the similar s ABF and a' b' F, 

 

as a' b' = ab = i. The ratio (f / i) is a constant for a particular instrument and is known as stadia interval factor, 
also instrument constant. It is denoted by K and thus 

d = K.s --------------------- Equation (23.1) 

The horizontal distance (D) between the center of the instrument and the station point (Q) at which the staff is 
held is d + f + c. If C is substituted for (f + c), then the horizontal distance D from the center of the instrument 
to the staff is given by the equation 

D = Ks + C ---------------------- Equation (23.2) 

The distance C is called the stadia constant. Equation (23.2) is known as the stadia equation for a line of sight 
perpendicular to the staff intercept. 

 

 

Determination of Tacheometric Constants 

The stadia interval factor (K) and the stadia constant (C) are known as tacheometric constants. 
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Before using a tacheometer for surveying work, it is reqired to determine these constants. These 
can be computed from field observation by adopting following procedure. 

Step 1 : Set up the tacheometer at any station say P on a flat ground. 

Step 2 : Select another point say Q about 200 m away. Measure the distance between P and Q 

accurately with a precise tape. Then, drive pegs at a uniform interval, say 50 m, along PQ. Mark the 
peg points as 1, 2, 3 and last peg -4 at station Q. 

Step 3 : Keep the staff on the peg-1, and obtain the staff intercept say s1 . 

Step 4 : Likewise, obtain the staff intercepts say s2, when the staff is kept at the peg-2, 

Step 5 : Form the simultaneous equations, using Equation (23-2) 

D1 = K. s 1 + C --------------(i) 

and D 2 = K. s 2+ C -------------(ii) 

Solving Equations (i) and (ii), determine the values of K and C say K1 and C1 . 

Step 6 : Form another set of observations to the pegs 3 & 4, Simultaneous equations can be 

obtained from the staff intercepts s3 and s4 at the peg-3 and point Q respectively. Solving those 
equations, determine the values of K and C again say K2 and C2. 

Step 7 : The average of the values obtained in steps (5) and (6), provide the tacheometric constants 

K and C of the instrument. 
 

 

Anallactic Lens 

It is a special convex lens, fitted in between the object glass and eyepiece, at a fixed distance from the object 
glass, inside the telescope of a tacheometer. The function of the anallactic lens is to reduce the stadia constant 
to zero. Thus, when tacheometer is fitted with anallactic lens, the distance measured between instrument station 
and staff position (for line of sight perpendicular to the staff intercept) becomes directly proportional to the staff 
intercept. Anallactic lens is provided in external focusing type telescopes only. 

Inclined Stadia Measurements 

It is usual that the line of sight of the tacheometer is inclined to the horizontal. Thus, it is frequently required to 
reduce the inclined observations into horizontal distance and difference in elevation. 

Let us consider a tacheometer (having constants K and C) is temporarily adjusted on a station, say P (Figure 
23.2). The instrument is sighted to a staff held vertically, say at Q. Thus, it is required to find the horizontal 
distance PP1 (= H) and the difference in elevation P1Q. Let A, R and B be the staff points whose images are 
formed respectively at the upper, middle and lower cross hairs of the tacheometer. The line of sight, 

corresponding to the middle cross hair, is inclined at an angle of elevation  and thus, the staff with a line 

perpendicular to the line of sight. Therefore A'B' = AB cos  = s cos  where s is the staff intercept AB. The 

distance D (= OR) is C + K. scos  (from Equation 23.2). But the distance OO1 is the horizontal distance H, 

which equals OR cos . Therefore the horizontal distance H is given by the equation. 

H = (Ks cos  + C) cos  

Or H = Ks cos2  + C cos  ----------------- Equation (23.3) 

in which K is the stadia interval factor (f / i), s is the stadia interval, C is the stadia constant (f + c), and  is the 
vertical angle of the line of sight read on the vertical circle of the transit. 
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The distance RO1, which equals OR sin , is the vertical distance between the telescope axis and the middle 
cross-hair reading. Thus V is given by the equation 

V = (K s cos + c) sin 

V = Ks sin  cos  + C sin  ----------------- Equation (23.4) 

 ----------------- Equation (23.5) 

Thus, the difference in elevation between P and Q is (h + V - r), where h is the height of the instrument at P and 
r is the staff reading corresponding to the middle hair. 

Uses of Stadia Method 

The stadia method of surveying is particularly useful for following cases: 

1. In differential leveling, the backsight and foresight distances are balanced conveniently if the level is 
equipped with stadia hairs. 

2. In profile leveling and cross sectioning, stadia is a convenient means of finding distances from level to 
points on which rod readings are taken. 

3. In rough trigonometric, or indirect, leveling with the transit, the stadia method is more rapid than any 
other method. 

4. For traverse surveying of low relative accuracy, where only horizontal angles and distances are required, 
the stadia method is a useful rapid method. 

5. On surveys of low relative accuracy - particularly topographic surveys-where both the relative location of 
points in a horizontal plane and the elevation of these points are desired, stadia is useful. The horizontal 
angles, vertical angles, and the stadia interval are observed, as each point is sighted; these three 
observations define the location of the point sighted. 

 

 

************** 

 

   

















Types of curves in surveying:- Horizontal and Vertical curves 

What are the Curves? 

Road curves are regular bends inroads to bring a gradual change of direction. similar curves are on 
railways and canals. Horizontal curves and vertical curves 

Curves provided in the horizontal plane are known as horizontal curves, whereas a curve that changes 
the slope grade of a road, allowing a vehicle to negotiate the elevation rate. 

Mainly curves are two type. 1.Horizontal Curves 2.Vertical Curves 

What is Horizontal curves? 

A horizontal curve is a curve in the plan provided to change the direction of alignment. In general, the flat 
curve should be used in conjunction with transition curves. As for a possible compound and reverse curve 
without transition should be avoided. To provide access to a particular locality. Making use of the existing 
right of way. 

Types of Horizontal curves 

 Simple curve. 

 Compound curve. 

 Reverse curve. 

 Transition curve. 

 Lemniscate curve 

 Spiral curve 

 Cubic parabolic curve 

Simple curve 

It is a circular curve that consists of a single arch of a uniform radius. It is generally represented of the 
angle subtended at its center by a chord of 30 m. or by the length of the radius can be calculated from the 
following equation. 

R = 1746.5/D 

Where 

R = radius of the curve. 

D = degree of curve. 



Simple curves Types of curves in surveying 

Compound curve 

This is a curve that is comprised of a series of two or more simple curves of different radius turning in the 
same general direction. This type of curve is used to avoid cutting or filling. They become advantages 
when a road has to be placed to fit a ground, like a layout between a river and a cliff, when the bend has 
to follow a specified path. 



Compound curve Types of curves in surveying 

Reverse curve 

This type of curve consists of two simple curves of the same or different radius which turn in the opposite 
direction. These curves are suitable for tracks lying in a hilly region and for cross over in station yards. 
When a circular curve consists of two reverse curves with or without any straight line in between, then it is 
known as the deviation curve. 

This type of curve is generally used at places of the accident, major repair work of the worn-out track. 
This keeps the track running in the original direction after deviation at the required place. 



Reverse curve Types of curves in surveying 

Transition curve 

When a vehicle entre or leaves a circular curve of finite radius. It is subjected to an outward centrifugal 
force. This causes a shock and away to the passenger and the driver. 

The primary purpose of the transition curve is to enable vehicle moving at high speeds to make the 
change from the tangent section to the curves section, to the tangent section of a track in a safe and 
comfortable fashion. 

The transition curve provides an increase of superelevation to the outer rail above the inner rail and thus 
reducing shocks or severe erk on the moving railway vehicle. 

It minimizes the wear of rails on curved provides comfort to the passenger due to the smooth running of 
the train. 

The most common type of transition curve 



Transition curve Types of curves in surveying 

Lemniscate curve – 

In this transition curve, radius decreases as the length increases, and hence there is a slight fall of the 
rate of gain of radial acceleration. 

L = C✓sin2h 

L = length of polar ray in metres 

h = polar angle in radions 

C = A constant 

Spiral curve – 

This an ideal transition curve. The radius of this curve is inversely proportional to length traversed. Hence 
the rate of change of acceleration in this curve is uniform throughout its length. 

Cubic parabolic curve – 



In the case of the curve the rate of decrease of curvature is much low for deflection angles4°to9° but 
beyond 9°there is a rapid increase in the radius of curvature. 

Y = X3/(6RL) 

Y = coordinate of any point 

R = radius 

L= length of curve 

What are Vertical curves? –   

A vertical curve is a curve in elevation provided at a change of gradients. Change of gradients becomes 
necessary due to the topography of a country and to reduce the quantity of earthwork. 

Types of vertical curves 

1. Summit curve. 

2. Valley curve. 

Summit curve 

1. A position grade meets a negative grade, 

2. A position grade meets another milder position graded, 

3. A position grade meets a level stretch, 

4. A negative grade meets a Steelers negative grade. 
The centrifugal force generated by the movement of a vehicle along a summit curve acts in a direction 
opposite to the direction in which it’s weight acts. 



Summit curves Types of curves in surveying 

Valley curve 

1. A negative grade meets a positive grades, 

2. A negative grade meets a milder negative grade, 

3. A negative grade meets a level stretch, 

4. A negative grade meets a Steelers positive grade. 
The centrifugal force generated by the vehicle moving on a valley curve acts in the same direction as the 
weight of vehicle. 



Valley curve 
The length of the vertical curve depends upon the algebraic difference in grades and 
determined by rates of change at which it is decided to change the gradient of the liner.  

 
Simple Circular Curve 

Once the alignment of a route is finalized, such as AVCD in Figure 37.1, the change in direction is 
achieved through provision of circular curves. In Figure 37.1, to change the direction from AV to VC, a 
circular curve T1 GT2 is provided. Similarly, from VC to CD, T'1G'T'2 is provided. The straight alignments, 
between which a curve is provided, are tangential to the curve. Thus, AT1 V and VT2C are tangential to 
T1 GT2 . The tangent line before the beginning of the curve is called the Back tangent or the rear tangent. 
The tangent line after the end of the curve is called the Forward tangent . The line AT1 is the back tangent 
and the line T2C is the forward tangent for the curve T1GT2. The distinction of the back tangent from the 
forward tangent depends on the direction of the route surveying. The point at which extension of the back 
tangent and the forward tangent meet is known as the Vertex (V) or point of intersection (P.I.). The 
exterior angle at the vertex or point of intersection is known as the Intersection angle (I). It is also known 

as Deflection angle () as it represents the deflection angle between the back tangent and the forward 
tangent. Thus, angle between the line AV produced beyond the vertex V and the line VC represents I 

(or ). The point on the back tangent where the curve begins is known as the Point of Curvature (P.C.). At 
this point, the alignment of the route changes from a straight line to a curve. This is represented by 
T1 in Figure 37.1. The point on the forward tangent where the curve ends is known as the Point of 
tangency (P.T.). At this point, the alignment of the route changes from a curve to a straight line. It is 
represented by T2 in Figure 37.1. The distance between the point of curvature (T1) to the point of 
intersection (V) along the extension of back tangent is known as Tangent distance (T). It is also equal to 
the distance between the point of tangency (T2) to the point of intersection along the extension of forward 
tangent. The distance between the point of intersection (V) and the middle point of the curve is called as 
External distance (E). The longest possible chord of the circular curve is known as Long chord (L). It is 
the line joining the point of curvature (T1) and the point of tangency (T2). The distance between the middle 
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point of the curve and the middle point of the long chord is Mid-ordinate (M). The length of the alignment 
along the curve between the point of curvature (T1) and the point of tangency (T2) is known as the Length 
of curve (l). During the progress of the route, if the direction of deflection is to the right then it is called 
Right-hand curve (T1GT2) and it is called left -hand curve, if the curve deflects to the left T'1G'T'2. 

 

 

Elements of a Simple Circular Curve 

Let T1GT2 be the circular curve that has been provided between the tangents AV and VC. The deflection 

angle,  between the tangents is measured in the field. The radius of curvature is the design value as per 
requirement of the route operation and field topography. The line joining O and V bisects the internal angles at V and 
at O, the chord T1T2 and arc T1GT2 . It is perpendicular to the chord T1T2 at F. From the Figure 37.1, RT1 O 

T2 =  and 

 

To compute the elements of a circular curve, consider the radius of the curve OT1 = OT2 = R. Further, it is known that 
the RVT1 O = RVT2 O = 90° (since the tangent to a circle is perpendicular to the radius at the point of tangency). The 
elements of a circular curve required to lay it out in the field with reference to Figure 37.1 are as follows : 

Length of Curve, 

l = T1 GT2 
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--------------Equation (37.1) 

Tangent Length, 

T = length T1 V = length T2 V 

--------------Equation (37.2) 

Chainages of tangent point : The chainage of the point of intersection (V) is generally known. Thus, 

Chainageof T1 = Chainage of V - tangent length (T) --------------Equation (37.3) 

Chainage of T2 = Chainage of T1 + length of curve (l) --------------Equation (37.4) 

Length of the long chord (L) : Length of the long chord, 

L = length T1 FT2 

--------------Equation (37.5) 

External distance (E) : 

E = length VG 

= VO - GO 

 

--------------Equation (37.6) 

Mid-ordinate (M) : 

M = length GF = OG-OF 

 

--------------Equation (37.7) 

Designation of a Curve 



A curve is designated either in terms of its degree (D) or by its radius (R). 

 

Degree of Curve 

The degree of a curve (D) is defined as the angle subtended at the centre of the curve by a chord or an 
arc of specified length. 

Chord Definition 

The degree of a curve is defined as the angle subtended at the centre of the curve by a chord of 30 m 
length. 

 

Let D be the degree of a curve i.e., it is the angle subtended at its centre O by a chord C1C2 of 30 m 
length as shown in Figure 37.2. Thus 

 

-------------- Equation (37.8) 
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Arc Definition 

The degree of a curve is defined as the angle subtended at its centre of the curve by an arc of 30 m 
length. 

 

 

From Figure 37.3, 

 

-------------- Equation (37.9) 

 
 

Radius of Curve 

In this convention, a curve is designated by its radius. The sharpness of the curve depends 
upon its radius. A sharp curve has a small radius. On the other hand, a flat curve has a large 
radius. Moreover, from (Equation 37.9), it can be found that the degree of curve is inversely 
proportional to the radius of curve. Thus, a sharp curve has a large degree of curve, whereas a 
flat curve has a small degree of curve. 

Examples 

Example 37.1 The deflection angle at the point of intersection (chainage 1256.260 m) of two 

straights is 43°. Find the elements of a 3° circular curve to be set out between the straights. 
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Solution Refer Figure 37.1 

From Equation37.1, the radius of the circular curve, 

R = 1718.9 / D = 1718.9 / 3 = 572.97 m ~ 573 m 

Let us consider, the radius of the circular curve to be set be, R = 575 m 

From given data, 

the deflection angle,  = 43° 

Thus, from Equation 37.2, tangent length T = R tan ( / 2) = 575 tan (43° / 2) 

= 226.498 m = 226.50 m 

Length of the curve, l = (From Equation 37.1) 

 

Chainage of T1 (the point of curve) = Chainage of P.I. – T 

= 1256.260 – 226.50 = 1029.676 m 

And Chainage of T2 (the point of tangency) = Chainage of P.C. + l 

= 1029.76 + 431.533 = 1461.293 m 

Length of the long chord, L = 2R Sin ( / 2) ------------------- (Equation 37.5) 

= 2 x 575 x Sin (43° / 2) = 421.476 m 

External distance, E =  ------------------- (Equation 37.6) 

=  

Mid-ordinate distance, M = R (1 – Cos ) -------------------(Equation 37.7) 
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=  
 

Example 37.2 To connect XY and ZY, by two right handed circular curves separated by a 
straight line AB, 250 m long, following measurements were made. 

WCB of the lines XY, ZY , AB are 45°, 300° and 90° respectively. The chainage of the station Y 
is 1000.00 m. A distance of 1 km is available for the curves alongwith the straight path. If the 
radius of the first curve is half of that of the second, calculate the following 

 The radii of the curves 
 The chainage of the point of tangencie 

Solution : 

(i) Deflection Angles 

Deflection angle for the first curve 

1 = Bearing of AB – Bearing of XY 

= 90° – 45° = 45° 

Deflection angle for the second curve 

2 = Bearing of YZ – Bearing AB 

= 120°– 90° = 30° 

Deflection angle for the straights XY and YZ 

 = 1 + 2 = 45° + 30° = 75° 

Bearing of YZ - Bearing of XY = 120° - 45° = 75° (Verified) 

(ii) Lengths of the Curves 

Length of the first curve of radius R, say 

l1 =  

Length of the second curve of radius, 2R 



l2 =  

Total length of the curve, l = l1 + l2 

(iii) Radius of the Curves 

Given, Total length of the curves + straight path = 1000 

or, l + 250 = 1000 

or,  

R = 409.26 m 

Let us provide, the first curve having radius, R = 410.0 m 

Thus, the radius of the second curve, 2R = 820.0 m 

(iv) Tangent Length 

Tangent length, T1 P = R tan = 410 tan = 169.827 m = PA 

Tangent length, T2 Q = 2R tan = 820 tan = 219.717 m = QB 

Thus, PQ = PA + AB + BQ 

= 169.827 + 250 + 219.717 = 639.544 m 

From  YPQ, 

 

PY = x Sin 30° = 331.054 m 

YT1 = YP + PT1 = 331.054+ 169.827 = 500.88 m 



Let us provide YT1 = 500 m; 

(v) Chainage 

Chainage of T1 = Chainage of Y – YT1 

= 1000 – 500.00 = 500.00 m  

Chainage of A = Chainage of T1 + l1 

= 500 + = 822.00 m 

Chainage of B = Chainage of A + AB 

= 822.00 + 250 = 1072.00 m 

Chainage of T2 = Chainage of B + l2 

= 1072.00 + = 1394.013 m 

Try Yourself:- 

Ex.37-1 A railway curve is to be tangential to each of the following lines : 

Lines W.C.B. Length (m) 

AB 0° - 

BC 90° 220 

CD 140° - 

Determine the salient parameters of the simple circular curve. 

Ex.37-2 Two straights AB and BC meet in an inaccessible point B and are to be connected by a simple 
curve of 600 m radius. Two points P and Q were selected on AB and BC respectively and the following 
data were obtained. 

R APQ = 150°, R CQP = 160°, PQ = 150.0 m 

Calculate the salient elements of the simple circular curve. Considering the chainage of point P to be 100. 

Answers 

For Exercise 37 

Ex.37-1 Radius = 150.04 m; Tangent lengths = 150.04 m and 69.96 m; Length of the curve = 361.61 m 

Ex.37-2 Chainage of tangent points 787.19 m and 1310.790 m 



 

 

























Map scale and basics of Map 

Map Scale, Coordinate Systems, and Map Projections 

All map users and map viewers have certain expectations about what is contained on a 

map. Such expectations are formed and learned from previous experience by working 

with maps. It is important to note that such expectations also change with increased 

exposure to maps. Understanding and meeting the expectations of map viewers is a 

challenging but necessary task because such expectations provide a starting point for the 

creation of any map. 

The central purpose of a map is to provide relevant and useful information to the map 

user. In order for a map to be of value, it must convey information effectively and 

efficiently. Mapping conventions facilitate the delivery of information in such a manner 

by recognizing and managing the expectations of map users. Generally speaking, 

mapping or cartographic conventions refer to the accepted rules, norms, and practices 

behind the making of maps. One of the most recognized mapping conventions is that 

“north is up” on most maps. Though this may not always be the case, many map users 

expect north to be oriented or to coincide with the top edge of a map or viewing device 

like a computer monitor. 

Several other formal and informal mapping conventions and characteristics, many of 

which are taken for granted, can be identified. Among the most important cartographic 

considerations are map scale, coordinate systems, and map projections. Map scale is 

concerned with reducing geographical features of interest to manageable proportions, 

coordinate systems help us define the positions of features on the surface of the earth, 

and map projections are concerned with moving from the three-dimensional world to 

the two dimensions of a flat map or display, all of which are discussed in greater detail 

in this chapter. 

 



Map Scale 

The world is a big place…really big. One of the challenges behind mapping the world and 

its resident features, patterns, and processes is reducing it to a manageable size. What 

exactly is meant by “manageable” is open to discussion and largely depends on the 

purpose and needs of the map at hand. Nonetheless, all maps reduce or shrink the world 

and its geographic features of interest by some factor. Map scale refers to the factor of 

reduction of the world so it fits on a map. 

Map scale can be represented by text, a graphic, or some combination of the two. For 

example, it is common to see “one inch represents one kilometer” or something similar 

written on a map to give map users an idea of the scale of the map. Map scale can also be 

portrayed graphically with what is called a scale bar. Scale bars are usually used on 

reference maps and allow map users to approximate distances between locations and 

features on a map, as well as to get an overall idea of the scale of the map. 

Figure 2.9 Map Scale from a United States Geological Survey (USGS) Topographic 

Map 

 

The representative fraction (RF) describes scale as a simple ratio. The numerator, which 

is always set to one (i.e., 1), denotes map distance and the denominator denotes ground 

or “real-world” distance. One of the benefits of using a representative fraction to 

describe scale is that it is unit neutral. In other words, any unit of measure can be used 



to interpret the map scale. Consider a map with an RF of 1:10,000. This means that one 

unit on the map represents 10,000 units on the ground. Such units could be inches, 

centimeters, or even pencil lengths; it really does not matter. 

Map scales can also be described as either “small” or “large.” Such descriptions are 

usually made in reference to representative fractions and the amount of detail 

represented on a map. For instance, a map with an RF of 1:1,000 is considered a large-

scale map when compared to a map with an RF of 1:1,000,000 (i.e., 1:1,000 > 

1:1,000,000). Furthermore, while the large-scale map shows more detail and less area, 

the small-scale map shows more area but less detail. Clearly, determining the thresholds 

for small- or large-scale maps is largely a judgment call. 

All maps possess a scale, whether it is formally expressed or not. Though some say that 

online maps and GISs are “scaleless” because we can zoom in and out at will, it is 

probably more accurate to say that GISs and related mapping technology are 

multiscalar. Understanding map scale and its overall impact on how the earth and its 

features are represented is a critical part of both map making and GISs. 

Coordinate Systems 

Just as all maps have a map scale, all maps have locations, too. Coordinate systems are 

frameworks that are used to define unique positions. For instance, in geometry we 

use x (horizontal) and y (vertical) coordinates to define points on a two-dimensional 

plane. The coordinate system that is most commonly used to define locations on the 

three-dimensional earth is called the geographic coordinate system (GCS), and it is 

based on a sphere or spheroid. A spheroid (a.k.a. ellipsoid) is simply a sphere that is 

slightly wider than it is tall and approximates more closely the true shape of the earth. 

Spheres are commonly used as models of the earth for simplicity. 

The unit of measure in the GCS is degrees, and locations are defined by their respective 

latitude and longitude within the GCS. Latitude is measured relative to the equator at 



zero degrees, with maxima of either ninety degrees north at the North Pole or ninety 

degrees south at the South Pole. Longitude is measured relative to the prime meridian at 

zero degrees, with maxima of 180 degrees west or 180 degrees east. 

Note that latitude and longitude can be expressed in degrees-minutes-seconds (DMS) or 

in decimal degrees (DD). When using decimal degrees, latitudes above the equator and 

longitudes east of the prime meridian are positive, and latitudes below the equator and 

longitudes west of the prime meridian are negative (see the following table for 

examples). 

Nominal location Absolute location (DMS) Absolute location (DD) 

Los Angeles, US 34° 3′ North, 118° 15′ West +34.05, –118.25 

Mumbai, India 18° 58′ North, 72° 49′ East +18.975, +72.8258 

Sydney, Australia 33° 51′ South, 151° 12′ East –33.859, 151.211 

Sao Paolo, Brazil 23° 33′ South, 46° 38′ West –23.550, –46.634 

Converting from DMS to DD is a relatively straightforward exercise. For example, since 

there are sixty minutes in one degree, we can convert 118° 15 minutes to 118.25 (118 + 

15/60). Note that an online search of the term “coordinate conversion” will return 

several coordinate conversion tools. 

When we want to map things like mountains, rivers, streets, and buildings, we need to 

define how the lines of latitude and longitude will be oriented and positioned on the 

sphere. A datum serves this purpose and specifies exactly the orientation and origins of 

the lines of latitude and longitude relative to the center of the earth or spheroid. 

Depending on the need, situation, and location, there are several datums to choose 

from. For instance, local datums try to match closely the spheroid to the earth’s surface 

in a local area and return accurate local coordinates. A common local datum used in the 

United States is called NAD83 (i.e., North American Datum of 1983). For locations in 



the United States and Canada, NAD83 returns relatively accurate positions, but 

positional accuracy deteriorates when outside of North America. 

The global WGS84 datum (i.e., World Geodetic System of 1984) uses the center of the 

earth as the origin of the GCS and is used for defining locations across the globe. 

Because the datum uses the center of the earth as its origin, locational measurements 

tend to be more consistent regardless where they are obtained on the earth, though they 

may be less accurate than those returned by a local datum. Note that switching between 

datums will alter the coordinates (i.e., latitude and longitude) for all locations of 

interest. 

Map Projections 

Previously we noted that the earth is really big. Not only is it big, but it is a big round 

spherical shape called a spheroid. A globe is a very common and very good 

representation of the three-dimensional, spheroid earth. One of the problems with 

globes, however, is that they are not very portable (i.e., you cannot fold a globe and put 

in it in your pocket), and their small scale makes them of limited practical use (i.e., 

geographic detail is sacrificed). To overcome these issues, it is necessary to transform 

the three-dimensional shape of the earth to a two-dimensional surface like a flat piece of 

paper, computer screen, or mobile device display in order to obtain more useful map 

forms and map scales. Enter the map projection. 

Map projections refer to the methods and procedures that are used to transform the 

spherical three-dimensional earth into two-dimensional planar surfaces. Specifically, 

map projections are mathematical formulas that are used to translate latitude and 

longitude on the surface of the earth to x and y coordinates on a plane. Since there are 

an infinite number of ways this translation can be performed, there are an infinite 

number of map projections. The mathematics behind map projections are beyond the 

scope of this introductory overview (but see Robinson et al. 1995; Muehrcke and 



Muehrcke 1998),Muehrcke, P., and J. Muehrcke. 1998. Map Use. Madison, WI: JP 

Publications. and for simplicity, the following discussion focuses on describing types of 

map projections, the distortions inherent to map projections, and the selection of 

appropriate map projections. 

To illustrate the concept of a map projection, imagine that we place a light bulb in the 

center of a translucent globe. On the globe are outlines of the continents and the lines of 

longitude and latitude called the graticule. When we turn the light bulb on, the outline of 

the continents and the graticule will be “projected” as shadows on the wall, ceiling, or 

any other nearby surface. This is what is meant by map “projection.” 

Figure 2.10 The Concept of Map “Projection” 

 

Within the realm of maps and mapping, there are three surfaces used for map 

projections (i.e., surfaces on which we project the shadows of the graticule). These 

surfaces are the plane, the cylinder, and the cone. Referring again to the previous 

example of a light bulb in the center of a globe, note that during the projection process, 

we can situate each surface in any number of ways. For example, surfaces can be 



tangential to the globe along the equator or poles, they can pass through or intersect the 

surface, and they can be oriented at any number of angles. 

Figure 2.11 Map Projection Surfaces 

 

In fact, naming conventions for many map projections include the surface as well as its 

orientation. For example, as the name suggests, “planar” projections use the plane, 

“cylindrical” projections use cylinders, and “conic” projections use the cone. For 

cylindrical projections, the “normal” or “standard” aspect refers to when the cylinder is 

tangential to the equator (i.e., the axis of the cylinder is oriented north–south). When 

the axis of the cylinder is perfectly oriented east–west, the aspect is called “transverse,” 

and all other orientations are referred to as “oblique.” Regardless the orientation or the 



surface on which a projection is based, a number of distortions will be introduced that 

will influence the choice of map projection. 

When moving from the three-dimensional surface of the earth to a two-dimensional 

plane, distortions are not only introduced but also inevitable. Generally, map 

projections introduce distortions in distance, angles, and areas. Depending on the 

purpose of the map, a series of trade-offs will need to be made with respect to such 

distortions. 

Map projections that accurately represent distances are referred to as equidistant 

projections. Note that distances are only correct in one direction, usually running 

north–south, and are not correct everywhere across the map. Equidistant maps are 

frequently used for small-scale maps that cover large areas because they do a good job of 

preserving the shape of geographic features such as continents. 

Maps that represent angles between locations, also referred to as bearings, are called 

conformal. Conformal map projections are used for navigational purposes due to the 

importance of maintaining a bearing or heading when traveling great distances. The cost 

of preserving bearings is that areas tend to be quite distorted in conformal map 

projections. Though shapes are more or less preserved over small areas, at small scales 

areas become wildly distorted. The Mercator projection is an example of a conformal 

projection and is famous for distorting Greenland. 

As the name indicates, equal area or equivalent projections preserve the quality of area. 

Such projections are of particular use when accurate measures or comparisons of 

geographical distributions are necessary (e.g., deforestation, wetlands). In an effort to 

maintain true proportions in the surface of the earth, features sometimes become 

compressed or stretched depending on the orientation of the projection. Moreover, such 

projections distort distances as well as angular relationships. 



As noted earlier, there are theoretically an infinite number of map projections to choose 

from. One of the key considerations behind the choice of map projection is to reduce the 

amount of distortion. The geographical object being mapped and the respective scale at 

which the map will be constructed are also important factors to think about. For 

instance, maps of the North and South Poles usually use planar or azimuthal 

projections, and conical projections are best suited for the middle latitude areas of the 

earth. Features that stretch east–west, such as the country of Russia, are represented 

well with the standard cylindrical projection, while countries oriented north–south (e.g., 

Chile, Norway) are better represented using a transverse projection. 

If a map projection is unknown, sometimes it can be identified by working backward 

and examining closely the nature and orientation of the graticule (i.e., grid of latitude 

and longitude), as well as the varying degrees of distortion. Clearly, there are trade-offs 

made with regard to distortion on every map. There are no hard-and-fast rules as to 

which distortions are more preferred over others. Therefore, the selection of map 

projection largely depends on the purpose of the map. 

Within the scope of GISs, knowing and understanding map projections are critical. For 

instance, in order to perform an overlay analysis like the one described earlier, all map 

layers need to be in the same projection. If they are not, geographical features will not be 

aligned properly, and any analyses performed will be inaccurate and incorrect. Most 

GISs include functions to assist in the identification of map projections, as well as to 

transform between projections in order to synchronize spatial data. Despite the 

capabilities of technology, an awareness of the potential and pitfalls that surround map 

projections is essential. 



Maps 

A map is a collection of map elements laid out and organized on a page. Common map elements include the map 

frame with map layers, a scale bar, north arrow, title, descriptive text, and a symbol legend. 

 

The primary map element is the map frame, and it provides the principal display of geographic information. Within 

the map frame, geographical entities are presented as a series of map layers that cover a given map extent—for 

example, map layers such as roads, rivers, place names, buildings, political boundaries, surface elevation, and 

satellite imagery. 

 

The following graphic illustrates how geographical elements are portrayed in maps through a series of map layers. 

Map symbols and text are used to describe the individual geographic elements. 

 

 

 

Map layers are thematic representations of geographic information, such as transportation, water, and elevation. 

Map layers help convey information through: 

 Discrete features such as collections of points, lines, and polygons 

 Map symbols, colors, and labels that help to describe the objects in the map 



 Aerial photography or satellite imagery that covers the map extent 

 Continuous surfaces such as elevation which can be represented in a number of ways—for example, as a 

collection of contour lines and elevation points or as shaded relief 

 

Map Layout and composition 

Along with the map frame, a map presents an integrated series of map elements laid out and arranged on a page. 

Common map elements include a north arrow, a scale bar, a symbol legend, and other graphical elements. These 

elements aid in map reading and interpretation. 

 

The map layout below illustrates how map elements are arranged on a page. 

 

 

 

Often, maps include additional elements such as graphs, charts, pictures, and text that help to communicate 

additional critical information. 

 

Spatial relationships in a map 

Maps help convey geographic relationships that can be interpreted and analyzed by map readers. Relationships 

that are based on location are referred to as spatial relationships. Here are some examples. 



 Which geographic features connect to others (for example, Water Street connects with 18th Ave.) 

 Which geographic features are adjacent (contiguous) to others (for example, The city park is adjacent to the 

university. 

 Which geographic features are contained within an area (for example, The building footprints are contained 

within the parcel boundary.) 

 Which geographic features overlap (for example, The railway crosses the freeway.) 

 Which geographic features are near others (proximity) (for example, The Courthouse is near the State 

Capitol.) 

 The feature geometry is equal to another feature (for example, The city park is equal to the historic site 

polygon). 

 The difference in elevation of geographic features (for example, The State Capitol is uphill from the 

water.)The feature is along another feature (for example, The bus route follows along the street network.). 

 

 

Within a map, such relationships are not explicitly represented. Instead, as the map reader, you interpret 

relationships and derive information from the relative position and shape of the map elements, such as the streets, 

contours, buildings, lakes, railways, and other features. In a GIS, such relationships can be modeled by applying 

rich data types and behaviors (for example, topologies and networks) and by applying a comprehensive set of 

spatial operators to the geographic objects (such as buffer and polygon overlay). 

Classification of Maps 

Millions of unique maps are in use throughout the world. Most of these maps can be placed 
into one of two groups: 1) reference maps; and, 2) thematic maps. 

Reference maps show the location of geographic boundaries, physical features of Earth, or 
cultural features such as places, cities, and roads. Political maps, physical maps, road 
maps, topographic maps, time zone maps, geologic maps, and zip code maps are all 
examples of reference maps. A variety of reference maps have been created for almost 
every country of the world. 

Thematic maps show the variation of a topic (the theme) across a geographic 
area. Weather maps showing daily high temperatures across the United States are familiar 
examples of a thematic map. They are made by starting with a reference map of the United 
States. Then temperature data is plotted atop of the reference map using colors to 
communicate the temperature forecast. Income maps and resource maps are other types 

of thematic maps. 

In the sections of this article below, you will find several examples of commonly used 
reference maps and thematic maps. 

 

https://geology.com/maps/types-of-maps/#political-maps
https://geology.com/maps/types-of-maps/#physical-maps
https://geology.com/maps/types-of-maps/#road-maps
https://geology.com/maps/types-of-maps/#road-maps
https://geology.com/maps/types-of-maps/#topographic-maps
https://geology.com/maps/types-of-maps/#time-zone-maps
https://geology.com/maps/types-of-maps/#geologic-maps
https://geology.com/maps/types-of-maps/#zip-code-maps
https://geology.com/maps/types-of-maps/#weather-maps
https://geology.com/maps/types-of-maps/#income-maps
https://geology.com/maps/types-of-maps/#resource-maps


Political Maps 

"Political maps" are among the most widely used reference maps. They are mounted on the 
walls of classrooms throughout the world. They show the geographic boundaries between 
governmental units such as countries, states, and counties. They show roads, cities and 
major water features such as oceans, rivers and lakes. 

Political maps help people understand the geography of the world. They are usually the first 
type of map that students are introduced to in school. They are also known as "reference 
maps" because people refer to them again and again as they have questions. 

Political maps are often printed on paper or another physical medium, but they can also be 
produced in digital form, suitable for viewing online. Every day millions of people visit search 
engines to find political reference maps. Some of the most popular searches are for "united 
states map", "world map", "europe map", and "florida map". 

Thousands of different political reference maps have been prepared to show the current 
geography of the United States. There are maps of the entire nation, maps for each of the 
50 states, maps of the 3142 counties (parishes in Louisiana, and boroughs in Alaska) that 
make up the states. Most counties, boroughs and parishes are further subdivided into even 
smaller political units. An incredible number of political maps have been prepared just to 
display the geography of the United States. 

The maps most commonly seen in classrooms and offices are political maps of the world, 
countries and continents. They are often annotated with push pins, sticky notes, 
photographs, marker flags and string to show the travels of a family, locations of a business, 
or other locations and activities worthy of display. 

Physical Maps 

Physical maps are designed to show the natural landscape features of Earth. They are best 
known for showing topography, either by colors or as shaded relief. Physical maps often 
have a green to brown to gray color scheme for showing the elevation of the land. Darker 
greens are used for near-sea-level elevations, with the color grading into tans and browns 
as elevations increase. The color gradient often terminates in shades of gray for the highest 
elevations. 

Rivers, lakes, seas and oceans are usually shown in blue, often with a light blue color for 
the most shallow areas and darkening in a gradient or by intervals for areas of deeper 
water. Glaciers and ice caps are shown in white colors. 

Physical maps usually show the most important political boundaries, such as state and 
country boundaries. Major cities and major roads are often shown. This cultural information 
is not the focus of a physical map, but it is often included for geographic reference and to 
increase the utility of the map for many users. 

 

https://geology.com/world/the-united-states-of-america-satellite-image.shtml
https://geology.com/world/the-united-states-of-america-satellite-image.shtml
https://geology.com/world/world-map.shtml
https://geology.com/world/europe-satellite-image.shtml
https://geology.com/state-map/florida.shtml
https://geology.com/store/wall-maps/
https://geology.com/store/wall-maps/


Road, Street and Highway Maps 

The digital mapping revolution caused an explosion of map creation in the 1990s. In 

1996, MapQuest, the first popular online mapping service, allowed anyone with internet access 

the ability to create customized maps of almost any location in the United States. 

Within a few months, millions of people had become "cartographers". They were soon producing 

more unique maps in a single day than had been created during the entire history of paper 

cartography! 

Today, Google Maps is the world's most popular online mapping system. In addition to maps, 

the service also provides travel route directions. It can create directions for people who are 

driving, taking public transportation, walking, cycling or taking a plane. 

Billions of unique maps, millions of travel routes, and millions of street views are created each 

day with Google Maps. It is the first place millions of people go to plan any type of travel. 

Google has another product named "Google Earth" that allows people to view streets, roads and 

satellite images within a single interface. Google Earth is a free download - the software installs 

on your computer and fetches the image directly from the Google Earth server. 

Finally, for people who want printed maps, the DeLorme Atlas & Gazetteer is a series of books 

that contain state-wide map coverage for individual states (or pairs of small adjacent states). The 

maps present a combination of road, topography, cultural and recreational information. These 

"hybrid maps" are a favorite of people who work and play outdoors in rural areas. 

Topoographic Maps 

 

Topographic Map of an area within Mammoth Cave National Park, Kentucky. This map shows Earth's topography using 

brown contour lines with a contour interval of 20 feet. Roads, place names, streams and other features are also shown. 

https://www.mapquest.com/
https://www.google.com/maps/
https://geology.com/google-earth/
https://geology.com/store/delorme-atlas.shtml


Areas on the map where the brown contour lines are close together have steep slopes. Areas where the contour lines are 

spaced far apart have gentler slopes.  

Topographic Maps 

Topographic maps are reference maps that show the shape of Earth’s surface. They usually do 

this with lines of equal elevation known as "contour lines", but elevation can also be shown 

using colors (second map), color gradients, shaded relief and a number of other methods. 

Topographic maps are frequently used by hunters, hikers, skiers, and others seeking outdoor 

recreation. They are also essential tools of the trade for geologists, surveyors, engineers, 

construction workers, landscape planners, architects, biologists and many other professions - 

especially people in the military. 

Topographic maps also show other important natural features such as lakes, rivers and streams. 

Their locations are determined by topography, making them important natural elements of 

topographic maps. 

Important cultural features are also shown on topographic maps. These include roads, trails, 

buildings, place names, bench marks, cemeteries, churches, schools and much more. A 

standardized set of special symbols has been developed for this use. 

Topographic maps have traditionally been printed on large sheets of paper with their four 

boundaries being lines of longitude and latitude. The United States Geological Survey is the 

most widely known organization for producing them. They produce a series of 7.5-minute 

topographic maps covering most areas of the United States (a 7.5-minute map shows an area that 

is 7.5 minutes of longitude by 7.5 minutes of latitude). These maps and maps of many other 

scales are available from USGS in both print and digital form. 

Commercial publishers of topographic maps include the DeLorme Atlas (paper maps in books 

with state-wide coverage) and MyTopo (a source of digital and paper maps in traditional 

topographic and topophoto formats - we are affiliates of MyTopo and receive a commission on 

referred sales). 

Weather Maps 

People use an incredible number of weather maps. They are used to show predicted 
temperatures, predicted precipitation, storm warnings of various kinds, wind speed and 
direction, chance of precipitation, type of precipitation, snow accumulation, frost prediction 
and many other aspects of weather. 

All of these weather maps are continuously updated to communicate the most current 
information. They are the world's most frequently consulted thematic maps. Weather maps 
are presented in newspapers, television programs and especially on websites. Delivering 
weather maps on websites and through web apps gives people around the world instant 
access to weather information. 

https://geology.com/topographic-physical-map/arizona.shtml
https://geology.com/world/africa-physical-map.shtml
https://geology.com/topographic-physical-map/texas.shtml
https://www.usgs.gov/products/maps/topo-maps
https://geology.com/store/delorme-atlas.shtml
http://www.mytopo.com/?pid=geology
http://www.mytopo.com/?pid=geology


Many weather maps are animated maps that show historical or projected changes in the 
weather. These are extremely useful for people who need to know how changes in weather 
will impact their travel, workday, recreation, and many other plans. 

Income Maps 

Income maps are a very common type of thematic map. They show variations of income across a 

geographic area. The standard mapped variable for an income map is median household income. 

Income tends to be highly geographic because rural portions of a state or country often have 

lower median household income than urban areas. Within urban areas, income can also be highly 

variable because neighborhoods tend to be populated by people with similar income levels. 

The United States Census Bureau is a regular producer of income maps for the United States and 

individual states. After each major census, the Bureau updates its set of income maps and makes 

them available to the public. The Census Bureau also makes "change in income maps". These 

show which geographic areas have experienced economic growth or economic decline over a 

specific time interval. 

Resource Maps 

Thematic maps are often made to communicate the geographic distribution of natural resources. 

These maps might show countries with the highest diamond production or the geographic 

extent of an oil or gas field. The map shown here illustrates the geographic pattern of solar 

generating capacity for the United States. 

Resource maps are important because they help governments understand their natural resource 

assets and the natural resource assets of their allies and potential enemies. Resource maps help 

mining companies target their exploration efforts. They are also important for assessing the 

transportation opportunities and problems associated with the distribution of resources and the 

location of where they are consumed. 

DEFENCE SERIES MAPS (DSM) - 

These are prepared on 1:250,000; 1:50,000 and 1:25,000 scales for the 
use of defence forces of India for supporting national security 
requirements. Technically maps of this series are based on WGS-84 
Datum and LCC Projection. They contain full features of map with grid, 
contours and other classified information without any dilution of 
accuracy; therefore, they are kept under restricted category. Survey of 
India is only authorized for preparation and printing of DSM. For sale 
and distribution the responsibilities are assigned to ADGMS (GSGS), 
Ministry of Defence, DGIS Enclave, Rao Tula Ram Marg, Delhi Cantt. 

 

https://geology.com/articles/gem-diamond-map/
https://geology.com/articles/utica-shale/
https://geology.com/articles/utica-shale/
https://geology.com/jobs/exploration-geologist/
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Open Ser ies Map
Home  Deesha  GIS  Works  What's New  Feedback  Privacy

'Open Series Map' have been introduced as per the National Map Policy of 2005 by Survey of India. For the same a new
map numbering system has been adopted instead of the previous India and Adjacent Countries (IAC).

The map series is based on Transverse Mercator projection on WGS-1984 datum. A numbering system based on
International Map of the World (IMW) is used.

Map numbering is of the form 'A-12A-1':

1. The IMW numbering system with minor modi�cation is used upto 1°×1°/1:250,000 scale.
a. Since the IMW map number for India will always start with 'N' (India being in the northern hemisphere), the �rst

letter is omitted.
b. The next alphabet and number of the IMW map number denotes the 6°×4° region of the IMW series. So sheet

with Kalyanpur (77.65489°E 24.11981°N) would be in 'G-43' (from NG-43): 

https://deeppradhan.heliohost.org/
https://deeppradhan.heliohost.org/whats-new.htm
https://deeppradhan.heliohost.org/feedback.htm
https://deeppradhan.heliohost.org/privacy.htm
http://www.surveyofindia.gov.in/files/nmp/National%20Map%20Policy.pdf
http://en.wikipedia.org/wiki/Survey_of_India
https://deeppradhan.heliohost.org/gis/map-numbering/iac.htm
https://en.wikipedia.org/wiki/Transverse_Mercator_projection
https://en.wikipedia.org/wiki/World_Geodetic_System#A_new_World_Geodetic_System:_WGS_84
https://deeppradhan.heliohost.org/gis/map-numbering/imw.htm
https://deeppradhan.heliohost.org/gis/map-numbering/imw.htm


c. Each 6°×4° rectangle is further subdivided into 24 squares of 1°×1°. Each square is indicated serially by an
alphabet increasing �rst towards east and then towards south, starting with 'A'. So sheet for Kalyanpur



(77.65489°E 24.11981°N) falls within 'G-43X': 

2. Each 1°×1° square is further divided into 16 squares of 15'×15' (15 minutes×15 minutes). Each square is indicated
serially by a number increasing �rst towards south and then towards east, starting with '1' (similar to the system
adopted in India and Adjacent Countries). So for the map sheet for Kalyanpur (77°39.293'E 24°7.187'N) would be 'G-
43X-12': 

Lookup Open Series Map map numbers in Map Number Lookup.

https://deeppradhan.heliohost.org/gis/map-numbering/iac.htm
https://deeppradhan.heliohost.org/gis/map-numbering/lookup.htm?mapSystem=OSM


Further Reading/References

Guidelines for Implementing National Map policy (has layout of OSM sheets on page 5, PDF - 904 KiloBytes).
National Map Policy (PDF - 41 KiloBytes).
Toposheet Number to OSM sheet Number (PDF - 655 KiloBytes).

http://www.surveyofindia.gov.in/files/nmp/Guidlines%20for%20Implementing%20National%20Map%20policy.pdf
http://www.surveyofindia.gov.in/files/nmp/National%20Map%20Policy.pdf
http://www.surveyofindia.gov.in/files/Topo2OSM.pdf
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Advanced Survey In this unit, an introduction to some important modern surveying equipment and 
their use has been explained. The first section deals with the angle measuring 
equipment such as micro-optic and electronic theodolites. In the next section, the 
EDM has been discussed. This is followed by a discussion on electronic and auto 
levels. The penultimate section provides details on the Total Station that can be 
used for angle, distance and height measurements in one go. In the last section, an 
introduction to the latest technology, namely GPS, has been provided. 

Objectives 
After studying this unit, you should be able to 

• get an overview of some commonly used modern surveying 
equipment and their uses, and 

• understand the working of these new generation equipment for field 
surveying jobs. 

5.2 MICRO-OPTIC AND ELECTRONIC 
THEODOLITES 

As you know that the survey field measurements include distances (horizontal 
and sloping) and angles (horizontal and vertical) measurement. The latter can be 
measured with a transit, or theodolite. You have already studied the use of vernier 
theodolites that are designed to read angles to the closest minute, 20 seconds or 
10 seconds. Over the years, the vernier theodolites have been in practice for 
conducting surveys of ordinary precision. For very precise surveys, these have 
been superseded by modern theodolites. The modern theodolites can be 
categorised as micro-optic and electronic theodolites. Unlike vernier theodolite, 
the observations are taken through an auxillary eyepiece (i.e. through optics) in 
the micro-optic theodolites and hence the name. In electronic theodolites, the 
observations are taken from the visual displays. These can read, record, display 
and store horizontal and vertical angles in the electronic recorder attached to 
them. 

5.2.1 Micro-optic Theodolites 
The design of these instruments is such that these become compact and 
light-weight. These are generally characterised by a three-foot screw levelling 
head and an optical plummet. There is a circular level for approximate levelling 
and a plate level for precise levelling. Optical plummet is provided for accurate 
centering particularly in windy climatic conditions. The plummet consists of a 
small eyepiece generally built into the tribach. The graduations are marked on 
horizontal and vertical circles made up of glass. The observations are read 
through an optical reading system that consists of a series of prisms. The vertical 
circle is normally graduated such that 0o corresponds to the telescope pointing 
upwards towards the zenith. The graduations increase clockwise with 90o and 
270o marked on the horizontal line and 180o on the vertical line pointing 
downwards towards the nadir. The glass circles are read with the aid of an 
eyepiece adjacent to the telescope. The angles can be read to a least count of 1″. 
Many manufacturers have developed a variety of micro-optic theodolites each 
having a particular optical system such as circle microscope system, optical scale 
system, single reading optical micrometer and double reading optical micrometer 
etc.  
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Modern Surveying 

Equipment
A list showing the performance of some of the direction measuring equipment is 
given in Table 5.1. 

Table 5.1 : Some Micro-optic Theodolites for Angle Measurement 

Least Count Sl. 
No. 

Name of Instrument Make 

Direct 
(Seconds)

Estimation 
(Seconds) 

1. T2 (Universal) Leica, Switzerland 1.0 0.5 

2. T3 (Precision) Leica, Switzerland 0.2 0.1 

3. T4 (Astronomy) Leica, Switzerland 0.1 0.05 

4. Theo 010 Zeiss, Germany 1.0 0.1 

Wild T3 theodolite is used for geodetic triangulation and all other precise surveys 
whereas Wild T4 theodolite is commonly used for astronomical determination of  
co-ordinates and azimuth. Wild T2 and Zeiss Theo 010 are commonly used for 
engineering surveys. 

5.2.2 Electronic Theodolites 
A major change in the design of theodolites has occurred in recent years with the 
introduction of electronic circle reading systems to their design. The electronic 
theodolites are similar to micro-optic theodolites in their design and operation. 
However, the difference lies in the system of taking reading. Here, the 
observations are taken through digital readouts or displays. The commonly used 
displays are Light-Emitting Diodes (LED) and Liquid Crystal Displays (LCD). 
The direct display of angular readings eliminates the guessing and interpolations 
associated with the vernier scale and micrometer readings in other theodolites. 
The angles can be measured to a least count of 1″ with precision ranging from 
0.5″ to 10″. One of the significant characteristics of these theodolites is that the 
data can be recorded in a data collector attached with the theodolite. The data can 
then be processed in a computer for subsequent analyses. The theodolites have a 
zero set button for initial setting of the readings. Once attached with EDM, it can 
then be used as a Total Station (to be discussed in Section 5.4 of this unit). A 
typical electronic theodolite is shown in Figure 5.1. 

 
Figure 5.1 : An Electronic Theodolite with Data Collector 
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Advanced Survey 5.2.3 Working of Micro-optic and Electronic Theodolites 
The working of these theodolites is more or less similar to that of a vernier 
theodolite. The major difference is in the centering procedure, which is through 
optical plummet instead of the conventional plumb bob centering. For an easy and 
quick set up, following steps may be followed : 

(a) Place the instrument over the point with the tripod plate as horizontal 
as possible. 

(b) From a distance of 1 to 2 meter, check if the instrument appears to be 
set over the station. If not, adjust the location and check again. Move 
in the direction 90o to the original setting and repeat the steps. 

(c) Through the optical plummet, look the station mark and then firmly 
push in the tripod legs into the ground. 

(d) Manipulate the levelling screws while simultaneously looking through 
the optical plummet until its cross hair is exactly over the station mark. 

(e) Level the theodolite with the circular bubble in the usual fashion. 

(f) Look into the optical plummet to confirm that its cross hair is quite 
close to the station mark. 

(g) The circular bubble can now be brought into centre by turning one or 
more levelling screws. 

(h) The tripod clamp is now loosened to slide the instrument on the flat 
tripod top till the optical plummet cross hair is exactly centered over 
the station mark. 

(i) The instrument can now be precisely levelled using longitudinal 
bubble in the usual fashion as we do in vernier theodolite. 

(j) Start measuring the horizontal and vertical angles. 

The instrument can be used for various surveying operations such as laying off 
angles, prolonging a straight line, balancing in, intersection of two lines etc. 

5.3 ELECTRONIC DISTANCE MEASUREMENT 
(EDM) 

For providing precise horizontal control using trilateration (Section 6.3.1 of this 
block), it is necessary that the distances be measured as accurately as possible. 
The advent of EDM has made this possible. The EDM was first introduced in the 
late 1950. Since then, many refinements to these equipment have been made. The 
earlier EDMs were very big, heavy and expensive. With the advancements in 
electronic and computer technologies, these have become smaller, simpler and 
less expensive. The EDMs come in two parts : the instrument and the reflector. 

The Instrument 

The EDMs are generally of two types : electro-optical systems and 
electronic systems. The electro-optical systems use either light and laser 
waves or infrared waves whereas electronic systems use microwaves. The 
microwave systems require transmitter/receiver at both ends of the line to 
be measured. The infrared system requires a transmitter at one end and a 
reflector at the other end. The microwave systems are capable of measuring 
distances up to a limit of 100 kms whereas the infrared EDMs come in three 
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INTRODUCTION
• TS should be in permanent adjustment before using it for

observations.

• Seldom achieved in practice and give rise to instrumental errors

in TS.

• To be ensured through regular monitoring of instrumental

errors

• one face measurements are rampant in field and thus, it is

important to determine the magnitude of the errors and correct

them.

• Instrumental errors can be measured and corrected using

electronic calibration.
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CALIBRATION
• Calibration parameters of a TS changes because of mechanical

shock, temperature changes, rough handling etc.

• Calibration of TS is to done following the procedure given in
manual of the instrument.

• Calibration should be done before deployment of instruments for field
observation

– for the first time

– after long storage

– After rough or long transportation

– After long periods of work

– Following big changes in temperature

– Regularly for precision work.
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CALIBRATION….
• Before calibration, TS should be in ambient

temperature

• Instrument s/w automatically apply

corrections as calibrations parameters get

determined.
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SOURCES OF ERRORS
The lack in permanent adjustment in TS leads to following instrumental errors

• HORIZONTAL COLLIMATION ERROR

• TILTING AXIS ERROR

• VERTICAL COLLIMATION

• COMPENSATOR INDEX ERROR

• ECCENTRICITY ERROR

• CIRCLE GRADUATION ERROR

• COLLIMATION OF LASER POINTER

Regular calibration adopting proper field procedures need to be implemented to

eliminate or reduce the effects of these errors.
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SOURCES OF ERRORS ….

HORIZONTAL COLLIMATION

• Axial error when line of sight is not perpendicular to the

horizontal axis

• Effects horizontal circle reading

• Increases with steep sightings

• Eliminated through both face observations.

• For single face observation, by finding out the angle of deviation

through calibration

• If exceeds limit, get adjusted through manufacturer.
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SOURCES OF ERRORS ….

TILTING AXIS ERROR
• When horizontal axis is not perpendicular to the vertical axis

• Causes line of sight in an inclined plane as the telescope is plunged

• Effects horizontal circle reading for tilted sight.

• Eliminated through both face observations and for equal BS & FS distances

• For single face observation, by finding out the tilting axis error through

calibration

• If exceeds limit, get adjusted through manufacturer.
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SOURCES OF ERRORS…

VERTICAL COLLIMATION

• When the 0 ° - 180° line of the vertical circle does not coincides

with the vertical axis.

• Effects vertical circle reading

• Eliminated through both face observations

• For single face observation, by finding out the index error, i

through calibration

• It gets applied directly to vertical angle

• If exceeds limit, get adjusted through manufacturer.
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SOURCES OF ERRORS….

COMPENSATOR INDEX ERROR
• Errors due to improper leveling of TS, gets compensated automatically

through compensator by measuring the residual tilt and applying corrections

to the horizontal and vertical circle readings.

• Compensators usually get longitudinal error, l in the direction of line of sight

and transverse error, l in the direction of perpendicular to l.

• Known as zero point errors

• Eliminated through both face observations

• For single face observation, by finding out the zero point errors through

calibration

• If exceeds limit, get adjusted through manufacturer.
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SOURCES OF ERRORS….

COLLIMATION OF LASER POINTER

• Arises in reflector less measurements using laser beam.

• Due to non-coincidence of the pointing of the laser beam with

the line of collimation

• Causes error in both circles readings as well as in distance.

• Eliminated through both face observations

• For single face observation, by finding out the angle of deviation

through calibration

• If exceeds limit, get adjusted through manufacturer.
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SOURCES OF ERRORS….

ECCENTRICITY ERROR
• If geometric centers of the graduated circles (Horizontal & Vertical) do not

coincide with the center of rotation.

• Errors are small

• By taking average of the measurements taken on opposite sides of the circles.

CIRCLE GRADUATION ERROR
• Non-uniform graduations around the circumference of a circle (Horizontal/

Vertical or both).

• Causes errors in both the circle measurements

• Errors are small

• Minimise or eliminate by taking measurements at different locations of

circles.
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Summary of Lecture 25

• Requires permanent adjustment in TS before using it for

observations.

• The lack in permanent adjustment in TS leads to : horizontal

collimation error, tilting axis error, compensator index error,

vertical collimation, collimation of laser pointer, eccentricity

error, circle graduation error.

• Regular calibration adopting proper field procedures are done

to eliminate or reduce the effects of these errors.

13



Review Questions
1. Write short notes on the following : (i)

Horizontal collimation error; (ii) Tilting
axis error; (iii) Compensator index error;
(iv) Vertical collimation error; (v)
Collimation of laser pointer error.

2. Explain how errors in TS may be eliminated
or reduced?
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Further reading

1. Surveying for Engineers (2006) by J. Uren &

W.F.Price

2. Elementary Surveying – An introduction to

Geomatics(2012) By C.D.Ghilani & P.R.Wolf.

Next Class  

“OTHER Errors in TS”
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Open Ser ies Map
Home  Deesha  GIS  Works  What's New  Feedback  Privacy

'Open Series Map' have been introduced as per the National Map Policy of 2005 by Survey of India.
For the same a new map numbering system has been adopted instead of the previous India and
Adjacent Countries (IAC).

The map series is based on Transverse Mercator projection on WGS-1984 datum. A numbering
system based on International Map of the World (IMW) is used.

Map numbering is of the form 'A-12A-1':

1. The IMW numbering system with minor modi�cation is used upto 1°×1°/1:250,000 scale.
a. Since the IMW map number for India will always start with 'N' (India being in the northern

hemisphere), the �rst letter is omitted.
b. The next alphabet and number of the IMW map number denotes the 6°×4° region of the

IMW series. So sheet with Kalyanpur (77.65489°E 24.11981°N) would be in 'G-43' (from
NG-43): 

https://deeppradhan.heliohost.org/
https://deeppradhan.heliohost.org/whats-new.htm
https://deeppradhan.heliohost.org/feedback.htm
https://deeppradhan.heliohost.org/privacy.htm
http://www.surveyofindia.gov.in/files/nmp/National%20Map%20Policy.pdf
http://en.wikipedia.org/wiki/Survey_of_India
https://deeppradhan.heliohost.org/gis/map-numbering/iac.htm
https://en.wikipedia.org/wiki/Transverse_Mercator_projection
https://en.wikipedia.org/wiki/World_Geodetic_System#A_new_World_Geodetic_System:_WGS_84
https://deeppradhan.heliohost.org/gis/map-numbering/imw.htm
https://deeppradhan.heliohost.org/gis/map-numbering/imw.htm


c. Each 6°×4° rectangle is further subdivided into 24 squares of 1°×1°. Each square is
indicated serially by an alphabet increasing �rst towards east and then towards south,
starting with 'A'. So sheet for Kalyanpur (77.65489°E 24.11981°N) falls within 'G-43X': 

2. Each 1°×1° square is further divided into 16 squares of 15'×15' (15 minutes×15 minutes). Each
square is indicated serially by a number increasing �rst towards south and then towards east,
starting with '1' (similar to the system adopted in India and Adjacent Countries). So for the
map sheet for Kalyanpur (77°39.293'E 24°7.187'N) would be 'G-43X-12': 

Lookup Open Series Map map numbers in Map Number Lookup.

Further Reading/References

Guidelines for Implementing National Map policy (has layout of OSM sheets on page 5, PDF -
904 KiloBytes).
National Map Policy (PDF - 41 KiloBytes).
Toposheet Number to OSM sheet Number (PDF - 655 KiloBytes).

https://deeppradhan.heliohost.org/gis/map-numbering/iac.htm
https://deeppradhan.heliohost.org/gis/map-numbering/lookup.htm?mapSystem=OSM
http://www.surveyofindia.gov.in/files/nmp/Guidlines%20for%20Implementing%20National%20Map%20policy.pdf
http://www.surveyofindia.gov.in/files/nmp/National%20Map%20Policy.pdf
http://www.surveyofindia.gov.in/files/Topo2OSM.pdf


Survey of India topographical maps: 

Reference scheme of Open Series 

Map (OSM) 

 

Anupam Das 

Panihati Mahavidyalaya 



'Open Series Map' have been introduced as per the National Map 

Policy of 2005 by Survey of India. 

 

 

Enhanced by the latest technology(RS and GIS) to meet the 

multidisciplinary needs of national security, suitable national 

development and new information market. 

 

 

The OSM  numbering system based on International Map of the 

World (IMW) is used. 

 

The 'International Map of the World (IMW)' was a project which 

started in 1913 to create a complete map of the world as per 

internationally agreed and consistent specifications 

 

http://www.surveyofindia.gov.in/files/nmp/National Map Policy.pdf
http://www.surveyofindia.gov.in/files/nmp/National Map Policy.pdf
http://www.surveyofindia.gov.in/files/nmp/National Map Policy.pdf
http://en.wikipedia.org/wiki/Survey_of_India
https://deeppradhan.heliohost.org/gis/map-numbering/imw.htm
https://deeppradhan.heliohost.org/gis/map-numbering/imw.htm
https://en.m.wikipedia.org/wiki/International_Map_of_the_World


Map numbering is of the form 'NA-

12A' 

 

•The first letter is either 'N' or 'S' to 

denote the hemisphere (North/South) 

with respect to the equator.  

 

•A second letter denotes the 4° 

latitude band with alphabet 

increasing as latitude moves away 

from equator. So sheets between 

12°N to 8°N would be 'NC' and 

between 4°S to 8°S would be 'SB'.  

The next number denotes the 6° longitude band with numbering starting at 1 from 

180°W (i.e. 1 between 180°W and 174°W) going on to 60 (i.e. between 174°E-

180°E). So sheet between 72° to 78°E and 12°N to 8°N will be 'NC-43'. Similarly 

between 132°W to 126°W and 4°S to 8°S would be 'SB-9'. The longitude band span 

increased to 12° from 60° latitude and to 24° from 76° latitude due to the decrease in 

physical span of longitude band. 

The International Map of the World series  



 

•Each 6°×4° rectangle is further subdivided into 24 squares of 1°×1°. Each square 

is indicated serially by an alphabet increasing first towards east and then towards 

south, starting with 'A'.  

 

•So for sheet between 74° to 75°E and 11°N to 

10°N we get 'NC-43I':  

For sheet between 128°W to 127°W 

and 6°S to 7°S we get 'SB-9Q': 



OSM  

NUMBERING SYSTEM 



The next alphabet and number of the IMW map 

number denotes the 6°×4° region of the IMW 

series. So sheet with Kalyanpur (77.65489°E 

24.11981°N) would be in 'G-43' (from NG-43): 

 

 
 

Each 6°×4° rectangle is further 

subdivided into 24 squares of 1°×1°. 

Each square is indicated serially by 

an alphabet increasing first towards 

east and then towards south, starting 

with 'A'. So sheet for Kalyanpur 

(77.65489°E 24.11981°N) falls 

within 'G-43X': 

 

 

 

Since the IMW map number for India will 

always start with 'N' (India being in the 

northern hemisphere), the first letter is 

omitted. 

DEGREE SHEET: G43X 
1:250,000 

Million sheets, 1: 1000,000 



Each 1°×1° square is further divided into 16 squares of 15'×15' (15 minutes×15 minutes). 

Each square is indicated serially by a number increasing first towards south and then towards 

east, starting with '1' (similar to the system adopted in India and Adjacent Countries). So for 

the map sheet for Kalyanpur (77°39.293'E 24°7.187'N) would be 'G-43X-12': 

15’ Sheet:G43X12 
1:50,000 

NW NE 

SW SE 

77030’ 

 
77045’ 

240N 

24015’ 

N 

Quadrant Sheet:G43X12NW 

1:25,000 

A 15’ minute 

sheet can be 

devided in two 

types: 
 

First, each sheet 

contains 4 

quadrant sheets 

(7’30” X 7’30”) 

on 1:25,000 scale 

and designated as 

NW, NE, SE and 

SW. 

https://deeppradhan.heliohost.org/gis/map-numbering/iac.htm


 A  F  K  P  U 

 B  G  L  Q  V 

 C  H  M  R  W 

 D  I  N  S  X 

 E  J  O  T  Y 

Second, each contains 25 sheets of dimension (3’X 3’) on 1:10,000 scale and are 

designated  by alphabets, A-Y. 

77030’E 

 
77033’ 

 
77036’ 

 
77039’ 

 
77045’ 77042’ 

240N 

24015’

N 

24003’ 
 

24006’ 
 

24009’ 
 

24012’ 

3’ Sheet:G43X12U 

1:10,000 

Each 3’-Sheet contains 25 sheets of 

(36” x 36”) on 1:2000 scale and are 

designated  by numerals, 1-25. 

 1  6  11  16  21 

 2  7  12  17  22 

 3  8  13  18  23 

 4  9  14  19  24 

 5  10  15  20  25 

77030’E 

 

7
7

0
3

0
’3

6
” 

 
77033’E 

7
7

0
3

1
’1

2
” 

 7
7

0
3

1
’4

8
” 

 7
7

0
3

2
’2

4
” 

 

These are the largest scale maps published      

by the SOI, larger than cadastral  

maps (1:4000). 

LS sheets 
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INTRODUCTION 

 • Acronym of NAVSTAR (Navigational Satellite for Timing 
and Ranging ) GPS (Global Positioning System); 

• A space-based all weather radio navigation system;   
• Provides precise PNT (position, navigation and time) to 

unlimited number of concurrent users all over the 
world continuously and nearly instantaneously, 24 
hours a day and 365 days in a year.  
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INTRODUCTION … 

 • Provides location in a three-dimensional global 
reference system; 

• Conducts accurate surveying even in real-time.  
• Much more efficient, economic, flexible and less time 

consuming in carrying out land surveying; 
• Provides significant gains in productivity over 

traditional surveying methods.  
• Brought a paradigm shift in the instrumentation and 

methods in land surveying. 
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GPS Architecture   

 

 
 
 

Three broad divisions: space segment (SS), control 
segment (CS) and user segment (US) 

• SS can interface with both CS 
and US through one way ranging 
signals in radio-frequency L band 
signals; 

• CS communicates with the SS 
through S band signal; 

• US receives one way ranging 
signals only from SS. 



SPACE SEGMENT 

•SS of GPS consists of pre-designed orbits around the earth and a 
constellation of satellites.  
•Orbits and satellite  constellation have been designed in such a way that a 
user, anywhere on earth under an open sky, does receive signals from at 
least four satellites at any time.  

• Orbits : 
• altitude ~ 20,200 km from the surface of 

the earth 
• nominally circular in shape  
• arranged in six equally-spaced orbits 

surrounding the Earth.  
• Orbital planes inclined at angle of 55 ̊ 

with equatorial plane  
• Have stationary ground tracks 

 

Satellite Constellation 
• At least four SVs in each orbit 
• Orbital period is 12 sidereal hours 
• Receives information from CS  
• Broadcasts one way ranging 

signals. 
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GPS SPACE SEGMENT 
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[https://en.wikipedia.org/wiki/File:GPS24goldenSML.gif] 



 
CONTROL SEGMENT 

 
Comprises :  
2 Master Control stations 
(MCS)  
16 Monitoring stations  
12 Ground Antennas  
 
 

 

Geo-locations of Control Stations 
  

Monitoring station  
• Check position, speed, 

altitude and health of 
tracked SVs  

• Collects GPS signals, 
navigation data, 
atmospheric data, gravity 
measurements and their 
variations.  

• Pass collected 
information to MCS. 
 



CONTROL SEGMENT…. 

Ground Antennas 

• collects, stores data from 
MCS 

• CS provides commands and  
keeps control on satellites;   

• Uploads to the GPS 
satellites using S band 
signals (2–4 GHz).  
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MCS  

• computes space coordinates 

 of SVs  

• Evaluates health of SVs 

• Generates navigation data  

• Performs satellite maintenance  

• Resolves satellites’ performance anomalies 

• Maintain optimal GPS constellation. 

• Through ground antennas, MCS provides 
commands, keeps control and uploads 
navigation messages and other data to the 
GPS satellites.  

 
 



USER SEGMENT….  

The user segment of GPS system consists of an electronic hardware, the GPS 
receiver and software. 
 

• GPS receivers 
fundamentally consist of 
three basic constituents: 
antenna, GPS receiver and 
controller and a controller. 

• Interconnected  
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USER SEGMENT…. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Software –  two fundamental types: the field software including firmware; 
and processing software.  

 

Different units of GPS user segment – their connectivity and functional flow diagram  
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Summary of Today’s Class 
• GPS surveying is efficient, economic, flexible and less time consuming. 
• GPS is being used for establishment of control points for land surveying. 
• GPS system consist SS, CS and US. 
• Only US is of concern to GPS users.  
• US comprises of GPS receiver and host of software. 
• GPS receiver consists of antenna, receiver and controller (field computer 

along with I/O).   
• Software comprises of firmware, OS, field software, Processing (Real 

Time & Post-processing) software and application software. 
• Different units of a receiver work as per instructions from controller 

through different software.   
• Receiver processes one way ranging L band signals from SVs and pass 

processed information to store or use further.  
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REVIEW QUESTIONS  
1. State relevance of control points in land surveying. 

2. Why GPS is being preferred for establishment of 
control point in digital land surveying? 

3. State the full name of GPS. Why it is called so? 

4. Explain the architecture of GPS system along with a 
line diagram. 

5. State and explain the working of the salient elements 
of the most important segment of GPS system in the 
perspective of user.  
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Further reading:  
• A Text Book on GPS Surveying by Jayanta Kumar Ghosh, CreateSpace 

Independent Publishing Platform (An Amazon Company), US 
[www.amazon.com/dp/1522952748]. 

• Ghosh, J.K., Ojaswa,S and Goyal, A (2006). Establishment of Local Control 
Points for Mapping using GPS, Geospatial World, October , pp  

• Ghosh, J.K. and Ch. V.A. Rao, (2001). GPS Control Point Positioning. Asian 
GPS Conference held at New Delhi (October 29-30, 2001) pp 43-46. 

•   

 

 

Meet You Next Class on “GPS SIGNAL” 
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INTRODUCTION 
• User segment receives broadcast signals from 

GPS SVs.  
• These GPS signals contain wealth of 

information.  
• To extract necessary data and desired 

parameters, users need to make use of 
particular portion of  the GPS signal   

• Thus, it is important for users to know & 
understand the contents  of a GPS signal. 
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COMPONENTS OF GPS SIGNAL 
GPS signals contain navigational data, code and carrier 
radio-waves. Data and code are put together first and 
then get modulated to carrier  frequency. 
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CARRIER WAVES 
• Required for safe transmission of GPS signal from SVs to user and 

for precise measurement of time. 
• From the beginning, SVs transmit GPS signal containing two 

carrier waves in radio-range: Link1 or L1 and Link2 or L2.  
• IIR/IIR(M) SVs transmit an additional component with L2 carrier, 

for civilians, known as L2C signal.  
• The block IIF SVs provide one more carrier L5  containing one full 

component for civil users.  
• Thus, at present, three full civil signals are available from GPS 

constellation.   
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LINK1(L1) Carrier Wave 

• Frequency 1575.42 MHz  or 154f0 MHz; 
•  Contains two types of codes 
  - P(Y)-code in phase and  
  - C/A-code in quadrature phase.  
• Both the codes are modulated to navigation data through 

modulo-2 addition.   
• The peak power spectral density of the C/A signal exceeds 

that of the P code L1 signal. 
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LINK2(L2C) Carrier Wave 

• L2C Civil Signal  
• Frequency 1227.60 MHz or 120f0  MHz carrier 
• Has higher effective power than L1 C/A signal and thus, available 

more under trees.  
• Can be acquired faster with higher reliability and has greater 

operating range.  
• L2C signal alone provides 65% more uncertainty in position than 

that of L1 C/A signal alone. 
• Availability of two civilian signals help in directly measure, and 

subsequently to remove ionospheric error. 
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LINK5(L5) Carrier frequency 

• Frequency - 115f0  or 1176.45 MHz carrier 
• contents depend on the SVs from which it is being transmitted.  
• In phase modulated with I5-code, NAV data and synchronization 

sequence.  
• Quadrature phase - modulation of Q5-code with different 

synchronization sequence. 
• Higher transmission power than L1 C/A or L2C signal, wider 

bandwidth, longer spreading codes etc.  
• L5 is the most advanced of the three Civilian GPS signals.  
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CIVIL SIGNALS 
•  In combination with L1 C/A and L2C, L5 provides a highly robust 

service for civilian users.  

• Each of the three civil GPS signals has one or more key 
advantages.  

  - L1 C/A has the lowest ionospheric error 

  - L2C has the best cross-correlation performance and  

  - L5 has the highest power and lies in ARNS (Aeronautical 
Radio Navigation Service) band.  

 Thus, each signal will be prevalent in its domain of strength. 
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RANGING CODES 
• Provide identification of  received signals and transmission time.   

• GPS signal contains  

 - Precision [P/P(Y) (for unauthorized user)] code as the principal 
navigation 

       - Coarse-Acquisition (C/A) PRN Code for acquisition of the precision 
code.  

 - L2 Civil-Moderate (L2 CM) code   

 - L2 Civil-Long (L2 CL) code  

 - I5 and Q5 codes (with L5) 
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Precision (P)-code 
•Precision (P)-code is the principal code of a GPS signal modulated to 
both L1 and L2 carriers.  
•It has chipping rate 10.23 MHz (f0) and of chip length 29.3 meter.  
•Period : 7 days and unique to each satellite.  
•Satellite gets identified by its PRN week number.  
•In order to restrict its accessibility to authorized users, P code gets 
encrypted with W code, a secret code of 20 bps, by modulo-2 
addition. This results in a code is termed as P(Y) code. 
•It is primarily deployed to obtain precise position by US military and 
its allies. 
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Coarse-Acquisition (C/A) Code 
• Chipping rate: 1.023 MHz (1023 Mbits)  

• Chip length : 293m 

• Period : 1 msec 

• Each satellite transmits a different set of C/A-
code. 
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Civil Codes 
L2 CM & L2CL  

• With L2 carrier in phase quadrature 

• Chipping rate  : 511.5 KHz (f0/20) 

L2CM 

• Consists of a stream of 10230 chips  

• Period: 20 milliseconds. 

• Modulated to CNAV data. 

• Provides PNT accuracy equivalent to that provided by the P-code for civil users.  

L2CL  

• Consists of a stream of 767250 chips  

• Period: 1.5 seconds.  

• No navigation data gets modulated with it.  
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I5 and Q5 Codes 
I5 & Q5   

• Available in L5 carrier of GPS signal  
•Chipping rate of 10.23 MHz (f0) 
•Period : 1 millisec 
•Contains PRN code  sequence of 10,230 chips.  
I5 (In-phase) 
•Contains modulated PRN codes with 10-bit Neuman-Hoffman code having chip rate 
of 1 kHz and NAV data  
Q5 (In Quadrature phase) 
•contains only modulated  PRN codes with 20-bit Neuman-Hoffman code at 1 kHz.  
Short synchronized Neuman Hoffman codes are provided for better spectral 
separation, bit synchronization and protection from narrowband interference. 
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NAVIGATIONAL DATA 
• GPS signal contain downlink system data, popularly known as 

navigational message or NAV data.  
• C/A and P (or P(Y)) codes are modulated to legacy navigation 

(LNAV) data, D(t);  
• L2 CM codes are modulated to civil navigation (CNAV) data, DC(t); 
• L5 I5 codes modulated to CNAV data of D5(t) variety.  
• navigation messages broadly contain SV ephemeris data, SV clock 

correction parameters, SV health data, information for authorized 
users, epoch of observation, time, user range accuracy index, 
signal delay information, atmospheric correction terms, UTC 
conversion parameter values etc. 
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Summary of Today’s Class 
•GPS users makes use of GPS signal broadcast by SVs. 
•GPS signal contains navigational data, PRN codes and carrier radio-waves. 
•GPS signal may contain three types of carrier waves- L1, L2 & L5; 5 different civil 
PRN codes (C/A, CM, CL, I5, Q5) and different navigational messages [Legacy 
navigation (LNAV) data with  C/A , Civil Navigation (CNAV) data, DC(t) with CM and 
D5(t) with I5]. 
•At present, three full civil signals are available from GPS constellation - L1 [C/A], L2C 
[CL or CM or C/A]  and L5 [I5 & Q5]. 
•Combinations of  L1 C/A, L2C and L5 provide a robust civilian service.  
•Individually,  L1 C/A has the lowest ionospheric error; L2C has the best cross-
correlation performance and L5 has the highest power and lies in ARNS.  
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Review Questions 

 1. How information about GPS signal will be helpful for GPS 
surveying. 

2. Explain in detail the contents of GPS signal. 
3. State functions of different components of a GPS signal.  
4. Write a brief note on navigation data. How navigation data is 

useful for GPS surveying? 
5. State and explain about the different types of cods available in 

GPS signal along with their relevance for GPS positioning.  
6. State and explain about the different types of frequencies 

available in GPS signal along with their specific utility in GPS 
surveying.  
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Further reading:  
• A Text Book on GPS Surveying by Jayanta Kumar Ghosh, 

CreateSpace Independent Publishing Platform (An Amazon 
Company), US [www.amazon.com/dp/1522952748]. 

 

Meet You Next Class on “GPS – USER SEGMENT” 

18 

http://www.amazon.com/dp/1522952748
http://www.amazon.com/dp/1522952748
http://www.amazon.com/dp/1522952748
http://www.amazon.com/dp/1522952748
http://www.amazon.com/dp/1522952748
http://www.amazon.com/dp/1522952748


Thanking You 



Lesson - 09 

GPS POSITION  
 

DR  JAYANTA  KUMAR  GHOSH 
CIVIL ENGINEERING DEPARTMENT 

1 



CONTENTS 

2 

1. INTRODUCTION 
2. GPS Position 
3. Conversion Geodetic to Cartesian 
4. Salient Surfaces  
5. Heights 
6. Height transformation 
7. Conversion Global to Local 
8. SUMMARY 
9. REVIEW QUESTIONS 
10. FURTHER READING 

 
 



INTRODUCTION 
• GPS Observations provides location of point in a 

global reference system.  

• to understand GPS positioning, it is required to 
know the different types of surfaces, heights.  

• engineering works get accomplished in local 
reference system.  

• to derive location in local reference, it is required 
to know the different types of conversions.  
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GPS Position 
Cartesian coordinates (X,Y,Z); 
• Origin  :  Centre of mass of the Earth including oceans and 

atmosphere.  
• Z-Axis  : The direction of IERS Reference Pole (IRP) – IRP 

directed towards CTP (Conventional Terrestrial Pole) as 
defined by BIH (the Bureau International de l’ Heure) with an 
uncertainty of 0.005”.  

• X-axis  : Intersection of IERS Reference Meridian (IRM) and 
the plane passing through the  and normal to the Z-axis. (IRM 
coincides with BIH zero meridian (epoch 1984.0) with an 
uncertainty of 0.005”).  

• Y-axis  : A right-handed, Earth Centered Earth Fixed (ECEF) 
orthogonal coordinate system, measured in the plane of the 
CTP Equator.  
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WGS 84…. 
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Reference Ellipsoid  
A geocentric ellipsoid of revolution with center of mass of the earth 
as origin and the Z-axis of the WGS 84 Coordinate System as the 
rotational minor axis having semi-major axis (a) : 6378137.0 m and 
reciprocal of flattening, 1/f  : 298.257223563.  
 
Geodetic Coordinates (φ, λ, h)  
Geodetic latitude (φ) of any location on the surface of the earth is 
the angle measured between the plane of the WGS84 ellipsoidal 
equator and the normal to the ellipsoid which extends to the 
earth’s location above the WGS84 ellipsoid.Geodetic longitude (λ) 
of any location on the surface of the earth is measured in the plane 
of the WGS84 ellipsoidal equator between the IRM (International 
Reference Meridian) and the meridian passing through the position. 
Geodetic height (h) is the distance of the point along normal from 
the WGS84 ellipsoid. 



Conversion : Geodetic TO Cartesian  
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SALIENT SURFACES  
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Three types  
(i) actual surface of the earth 
(ii)  geoid, a geo-equipotential surface 

that best approximates the mean sea 
level around the earth 

(iii) Ellipsoid, a geometrical figure of the 
earth that is defined by an ellipse 
revolved about its minor axis 



 
HEIGHTS 

 • Ellipsoid height : height of a point on the surface of the earth with 
reference to an ellipsoid surface as datum.  

• Orthometric Height (H): height of a point on the surface of the 
earth with earth’s geoid surface as datum.  

• Geoid height (N): The separation between a reference ellipsoid 
(WGS 84 for GPS) and earth’s geoid is called the geoid height or 
geoidal undulation i.e., the height of the geoid above the 
ellipsoid, N, is called the geoid undulation.  

• EGM2008 
• Online computation can be carried out using the URL 

(http://geographiclib.sourceforge.net/cgi-bin/GeoidEval) 
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HEIGHT TRANSFORMATION 
• Depending on the 

position of the geoid 
and ellipsoid surfaces, 
the relation between 
orthometric height (H) 
and its geodetic height 
(h) is given by H=h ± N  
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GLOBAL TO LOCAL (N,E,H) 
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Summary of Today’s Lesson 
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GPS provides positions in WGS84 Cartesian coordinates (X, Y, Z) as 

well as Geodetic Coordinates (φ, λ, h). 

Three prominent surfaces of the Earth are the actual surface 

of the earth, the geoid and  an ellipsoid. 

Three types of heights: Ellipsoids, Orthometric & Geoid 

height. 

Orthometric height i.e., height above geoid is the important 

for engineering works. 

Civil engineering works primarily makes use of  Local 

coordinates in North, East and Vertical height system. 

 

 

 



REVIEW QUESTIONS  
1. How GPS provides the position of a point/ station. Explain 

through labeled figures? 
2. How geodetic coordinates of any point/ station may be 

converted to its Cartesian coordinates? 
3. Name and explain the different surfaces of the earth along with 

a diagram. 
4. Define the following terms along with their significance in 

surveying: ellipsoidal height, Orthometric height and Geoid 
height.  

5. How do we define the local coordinates of a point? Explain how 
local coordinate of a point may be obtained.  
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Further reading:  
• A Text Book on GPS Surveying by Jayanta Kumar Ghosh, 

CreateSpace Independent Publishing Platform (An Amazon 
Company), US [www.amazon.com/dp/1522952748]. 

• Ghosh, J.K., Ojaswa,S and Goyal, A (2006). GPS Based Control 
Points for Mapping, Coordinates, October , pp 24-27.  
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INTRODUCTION 

• GPS surveying is being carried out to 
determine the position of points using signals 
received from GPS SVs.  

• Unknown positions are determined the 
principle of Analytical RESECTION 
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PRINCIPLE OF GPS POSITIONING 
• Unknown position determined from known distances  of  

three pre well-defined positions. 
• Three known positions and their three known distances 

from the unknown position (represented by three 
unknown coordinates) provide three distance 
equations. Solution of these three equations provides 
location of unknown position.  

• In GPS, satellites positions and their ranges (distances of 
the satellites from the receiver) are available in their 
respective signals. 

• From these data, unknown position of the receiver  get 
computed applying the method of resection. 

• Clock synchronization error is considered as fourth 
unknown thus need signal from at least four satellites. 
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GPS Observables 

 • Two types : code pseudo-range and phase observables; 
• Either or both are used for GPS positioning.  
• Code pseudo-ranges for autonomous and less 

precise/accurate positioning  
• Phase observables for more precise/accurate positioning.  
• Phase positioning makes use of code position as the basis 

for its precise positioning.  
• GPS observables biased with errors. 
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GPS Observables… 
CODE PSEUDO-RANGE 

• Computed by multiplying the time of transmission of GPS code 
signal (from the SV to user receiver) with its velocity of 
propagation. 

• Ranges based on these measurements do not represent the true 
ranges of SVs but their pseudo-ranges.  

• PR1 = TR1 +c.tr + E 
 where, PR1 represents code pseudo-range between a satellite and 

a receiver;TR1 represents true/geometric-range within between 
the satellite and the receiver; c.tr is receiver clock error; e is the 
error in peudo-range observable.   
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GPS Observables… 
CARRIER PHASE OBSERVABLE  

• The carrier phase of a GPS signal at the epoch of its emission from SV differs from its phase at the epoch 
of its reception by user receiver.  

• Difference in phase of a GPS signal at the epoch of its emission from SV from its phase at the epoch of its 
reception by user receiver.  

• Includes  integer number of cycles of the carrier frequency between these epochs  

• During GPS observation, receiver measures fractional part of phase difference.  

• Receiver also keeps count of the number of cycles that have been arrived from the satellite since its first 
epoch of measurement.  

• Number of full cycles that the signal travelled between the SV and receiver before the first epoch of 
measurement remains unknown and known as integer ambiguity. 

• Integer ambiguity remains associated with all the measurements  

• Carrier phase observables are associated with errors (E, in terms of phase angle).  

• Error associated with carrier phase observables is different from that associated with pseudo-range.  

• Carrier phase observables of different carrier frequencies i.e., of the L1, L2 and L5 will be different. 
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QUALITY OF GPS OBSERVABLES 

 
• Quality of the observables also depends on the amount of errors 

associated with them.  

• Errors associated with GPS observables are analyzed in terms of their 
effect on the range determination.  

• Quantities like Dilution of precision (DOP), User range accuracy (URA), 
user range error (URE) helps to define/designate quality of GPS 
observables. 
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QUALITY OF GPS OBSERVABLES: SATELLITEGEOMETRY 

 • Quality of GPS observables also depends on the satellites-receiver geometry at the epoch of its 
observation.  

• Good geometry if these are spatially well distributed in the sky considering zenith point of the receiver 
as the entre for distribution.  

• Poor geometry if SVs are in clustered form  
• Good geometry provides better quality observables and poor of degenarated quality.  
• Geometry quantified through dilution of precision (DOP).   
• DOP values defines the quality of the GPS observables.  
• Lower the DOP value, better is the quality of observables.  
• Guiding DOP values depend on the type of surveying.   
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QUALITY OF GPS OBSERVABLES: URA  

 USER RANGE ACCURACY (URA) 
• URA of any particular GPS signal is being specified in its navigation 

message.  

• In word three, bits 13 through 16 provide the URA index of the SV.   

• URA value is a conservative estimate of  RMS error for estimation of 
accuracy in pseudorange measurements. 
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QUALITY OF GPS OBSERVABLES: URE  

 
User Range Error (URE) 

• Error budget present in measurement of range between a user's receiver 
and the observation satellite is known as user range error (URE). 

• URE is being computed by taking square root of the sum of the squares 
of the individual errors.   
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Summary of Today’s Class 
1. Analytical Resection is the PRINCIPLE for GPS positioning. 
2. Ranges of the satellites get obtained from GPS observables  
3. GPS observables are of Two types : code pseudo-range and phase observables. 
4. Code pseudo-range  is obtained multiplying the time of transmission of GPS code signal 

(from the SV to user receiver) with its velocity of propagation. 
5. Difference in phase of a GPS signal at the epoch of its emission from SV from its phase at 

the epoch of its reception by user receiver. Includes  integer number of cycles of the carrier 
frequency between these epochs.  

6. Number of full cycles that the signal travelled between the SV and receiver before the first 
epoch of measurement remains unknown and known as integer ambiguity. 

7. Observables contain errors. Thus, observables are pseudo-ranges. 7. Quality of the 
observables also depends on the amount of errors associated with them.  

8. Quantities like Dilution of precision (DOP), User range accuracy (URA), user range error 
(URE) helps to define/designate quality of GPS observables.  

9. Lower the DOP value, better is the quality of observables. 
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REVIEW QUESTIONS 

 1. State and explain the basic principle of GPS positioning. 
2. Explain why we need observations from at least four satellites 

for GPS positioning. 
3. What is GPS observables? How many types of GPS observables 

are there? State primary uses of GPS observables. 
4. Write notes on : (i) Code observable; (ii) Phase observable; (iii) 

Integer Ambiguity; (iv) Satellite Geometry. 
5. How nature of Code observable differs from Phase observable. 
6. State and explain some quantities which define the quality of 

GPS observables.   
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Further reading:  
• A Text Book on GPS Surveying by Jayanta Kumar Ghosh, 

CreateSpace Independent Publishing Platform (An Amazon 
Company), US [www.amazon.com/dp/1522952748]. 
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Creating Maps in ArcMap: A Quick Guide 

Overview 
Making maps in ArcMap is very easy: Browse geospatial data in ArcMap and choose an appropriate 

presentation. This workshop will guide you through all necessary steps in the following table. 

No. Steps 
Sections 
to check 

Difficulties 

1 
Load geospatial data and basemap  into 
ArcMap 

1.1 Data formats and folder connection 

2 
Identify the features and attributes to 
present 

1.3 
Layer order, feature selection, and 
(briefly) frequent-used projections 

3 Define how to show the data 2.2 
Transparency (raster and vector), data 
classification, and layer file 

4 Add maps components 2.3 Geospatial data references 

5 Export maps 2.4 Resolution and file formats 

Table of Contents 
1. Browse Geospatial Data .................................................................................................................. 2 

1.1. Load Data ................................................................................................................................ 2 

1.2. Add Basemap........................................................................................................................... 5 

1.3. Browse the Data …………………………………………………………………………………………………………………… 7 

2. Mapping.......................................................................................................................................... 8 

2.1. Distinction between Geospatial Data and Map Components .................................................... 9 

2.2. Key Options of Geospatial Data Representations ................................................................... 10 

2.3. Map Components .................................................................................................................. 19 

2.4. Map Printing (Exporting) Options ........................................................................................... 23 
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1. Browse Geospatial Data 

1.1. Load data 
To launch ArcMap, please click: Start -> All Programs -> ArcGIS -> ArcMap 10. By default, a start-up 

splash window will appear once ArcMap has loaded (Figure 1).  

Click OK to proceed. You can ignore all other options. They are redundant. 

 

Figure 1. The start-up splash window of ArcMap 

There are two ways to add data: Click the Add Data  button (Figure 2), which opens a window 

similar to Figure. 

 
Figure 2. Main Windows with Marks on Add Data and ArcCatalog 

Add Data ArcCatalog 



 1.1 Load data  
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Figure 3. The Pop-up Window of "Add Data" 

To browse to the file you want to play with, you can link to the folder containing all these files by clicking 

the Connect to Folder  button in Figure 3, then browse to add the folder that contains your files 

and click OK. After that, you can locate the files listed below and add them in at one time by holding the 

Ctrl or Shift button when you are clicking mouse button to make selections. Please click the Add button 

just like any other file explorer dialogs in Windows to close the dialog.  

 Public_schools.shp: All public school locations in the City of Waterloo; 

 waterloo_city.shp: The administrative boundary of the City of Waterloo; 

 waterloo_streets.shp: Street network in the City of Waterloo; 

When data is loaded, all files will be listed in the left pane (table of contents) in Figure 4. The geographic 

features (contents) are displayed in the right pane. And most controls can be found on the top pane (or 

by right-clicking on the object you are working at and checking the pop-up window). 

 

Connect to 

Folder 



 1.1 Load data  
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Frequently-used File Formats in ArcGIS: 
 Feature Data: Feature data are usually organized as points, lines, and polygons in vector 

format. 
o Shapefile: The most commonly used geospatial data format. Although it appears to 

be one file in ArcMap, shapefile includes multiple files with the same file name, but 
different extensions. *.shp, *,dbf, and *.shx are must-have.  

o Personal Geodatabase: These files are based on Micriosoft Access (*.mdb). From 
user perspective, all kinds of geodatabase are the same, which include multiple layers 
(different geospatial data) in one geodatabase. 

o File Geodatabase: File geodatabase is a folder that contains geospatial data, which 
is newly introduced to ArcGIS. In ArcMap, file geodatabase is shown as a file rather 
than a folder. This might be the reason why ESRI adds “connect to folder” in ArcMap 
10. Hence, when you navigate to the file you want to open but are unable to do 
so, ALWAYS check if you should go one level upper to link to the folder first. You 
can open the file in the next step. 

o Further Reading:  
 http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/Types_of_g

eodatabases/003n00000007000000/ 
 http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/About_geo

graphic_data_formats/00r90000006r000000/ 
 Raster Data: Raster data uses grid to represent a region with values as a “field”. Images 

explicitly have the parameter of resolution. Typical raster data is: 
o GeoTIFF: They have the file extension of *.tif. The key difference between normal TIFF 

file and GeoTIFF is that GeoTIFF has projection information. Hence, normal TIFF files 
cannot be correctly added to the desired location. 

o GeoJPEG: Similar to GeoTIFF, but they have *.jpg extension. 
o Usage: Raster data can be air photos, satellite images, elevation data (DEM). But 

raster data tends to be huge and slow to load. 
 External Data: ESRI also supports some file formats produced by other vendors due to their 

popularity. Typical ones are: 
o AutoCAD: *.dwg files can be added, imported and converted into ArcMap. 
o Google Earth: *.kml files are supported by ArcGIS as well. However, conversion from 

KML into Shapefile is required, which can be done using ArcToolbox or some online 
services. 

o Further Reading: Wikipedia on GIS File Formats 
http://en.wikipedia.org/wiki/GIS_file_formats 

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/Types_of_geodatabases/003n00000007000000/
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/Types_of_geodatabases/003n00000007000000/
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/About_geographic_data_formats/00r90000006r000000/
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/About_geographic_data_formats/00r90000006r000000/
http://en.wikipedia.org/wiki/GIS_file_formats
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Figure 4. Structure of the Main Window 

1.2 Add a ESRI Basemap  

 

When users want to overlay a basemap and city boundary (waterloo_city.shp) together to produce a 

map like Google map View (i.e. http://maps.google.ca/maps?q=waterloo,+ontario&hl=en&ll=43.48257,-

80.533905&spn=0.134519,0.219727&sll=43.470394,-

80.538411&sspn=0.016818,0.027466&hnear=Waterloo,+Waterloo+Regional+Municipality,+Ontario&t=

m&z=12), they can add a basemap directly from Esri Basemap (Internet).   

To add a basemap, go to File -> Add data -> Add Basemap Layer (Figure 5) 

 

Data View 
Window 

Controls and 
Menus 

Table of 
Contents 

http://maps.google.ca/maps?q=waterloo,+ontario&hl=en&ll=43.48257,-80.533905&spn=0.134519,0.219727&sll=43.470394,-80.538411&sspn=0.016818,0.027466&hnear=Waterloo,+Waterloo+Regional+Municipality,+Ontario&t=m&z=12
http://maps.google.ca/maps?q=waterloo,+ontario&hl=en&ll=43.48257,-80.533905&spn=0.134519,0.219727&sll=43.470394,-80.538411&sspn=0.016818,0.027466&hnear=Waterloo,+Waterloo+Regional+Municipality,+Ontario&t=m&z=12
http://maps.google.ca/maps?q=waterloo,+ontario&hl=en&ll=43.48257,-80.533905&spn=0.134519,0.219727&sll=43.470394,-80.538411&sspn=0.016818,0.027466&hnear=Waterloo,+Waterloo+Regional+Municipality,+Ontario&t=m&z=12
http://maps.google.ca/maps?q=waterloo,+ontario&hl=en&ll=43.48257,-80.533905&spn=0.134519,0.219727&sll=43.470394,-80.538411&sspn=0.016818,0.027466&hnear=Waterloo,+Waterloo+Regional+Municipality,+Ontario&t=m&z=12
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Figure 5 Steps to add a basemap layer 

Currently 12 different basemaps are available. You can select either ‘Street’ or ‘Topographic’ as the 

basemap (Figure 6).  

 

 

Figure 6. ESRI basemap layers 



 1.3 Browse Geographic Features  
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1.3 Browse Geographic Features 
In ArcMap 10, ESRI starts to put most controls to browse data into one tool bar (Figure 7). If you cannot 

find this toolbar, please go to Customize -> Toolbars and check the Tools on.   

 

Figure 7. The Toolbar with Data Browsing Controls 

Most icons are intuitive and self-explained. If you are not sure what function it has, please put your 

mouse on that icon. A pop-up text will show and further explanation. In Figure 7, an example is shown 

when the mouse is hovering over the icon . The pop-up window explains its functionality: “Select 

Features by Rectangle”, which means that you can draw a rectangle over some area, and all features 

within (or have parts within) this rectangle will be selected for further operations.  

In addition to the toolbar, some functions on attribute data are put in the pop-up window when you 

right click on one layer (a geospatial data file or a feature class) in the table of contents (Figure 8). When 

you click on “Open Attribute Table”, a table with all information on features will be shown (Figure 9). 

 

Figure 8. Pop-up Window with Options on a Layer 



 1.3 Browse Geographic Features  
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Figure 9. Attribute Data Window 

These controls can be classified and summarized into the following table: 

 Geographic Operations Attribute Operations 

Browse  
Right-click on the layer (Figure 8 and 9) 

Search/Identify 
  

Select  (Figure 9) 
 

 

Select by 
Attributes 
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2. Mapping 

2.1. Distinction between Geospatial Data and Map Components 
This section is more concept- oriented. To simplify mapping process, ArcGIS divides mapping into two 

categories: data view, which focuses on data manipulation and representation (symbology), and layout 

view, which provides functionality of adding legend, scale bar, north arrow, etc.  

 All data representations should be set in data view. Key operations include the change of layer 

order, symbology customization, layer transparency, labeling, and annotations. Most of data 

representations can be saved in a layer file (*.lyr), because they are more data associated.  

 Layout view shows the virtual map you will get. Layout view works in a What You See Is What 

You Got (WYSIWYG) fashion. The output will be the same as what you see in the layout view, 

where you can add map elements and change the paper and output settings. Map setting will be 

save in a *.mxd file. 

 

Figure 10. Switch between Data View and Layout View 

Switch Menu 

Switch Button 
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2.2. Key Options of Geospatial Data Representations 
Main options of changing geospatial data representations are layer order, layer transparency, 

symbology, label, and annotation. Apart from the first one (layer order) and last one (annotations), all 

the rest locate in the pop-up window (Figure 11) when you right-click the layer you want to modify and 

select ‘Properties’ (Figure 12). They are under either the symbology or labels tab.  

 

Figure 11. Pop-up Window of a Layer's Property 

 

Figure 12. The Properties Window 

All options will be introduced as subsections in the following. 

 

Properties 

Symbology 

Labels 
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2.2.1. Layer Order and Transparency 

 

The boundary layer (waterloo_city.shp) can be made as “halo” (no fill color) polygons allowing the 

overlaying basemap to be visible. The detailed steps will be introduced after the concept of layer order. 

Layer Order 

ArcMap displays geospatial data according to the order in the table of contents: the bottom layer will be 

drawn on the screen first and covered by upper layer. Hence, the layer on the top in the table of content 

will be displayed as the top layer in the map. By default, ArcMap shows points, lines, polygons, and 

raster data (images, DEMs, etc) from the top to the bottom respectively so that the visibility is 

maximized. If two layers belong to the same feature class, i.e., point features, the newly added one will 

be on top of the older one. 

When there are multiple raster files, layer visibility and order are important. You can change layer 

visibility by switching the checkboxes left to the layer name in table of contents (Figure 13). And the 

display order can be changed by simply dragging the layer toward or away from the top.   

  

                                Figure 13. Layer Visibility and Order Control 

 

 

Visibility 
Checkbox 

Drag to change order 

Waterloo City as 
polygon covers the 

basemap 
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Layer Visibility 

When a polygon layer, such as waterloo_city, is added over an image (basemap), the image under the 

polygon is invisible (Figure 13). But users often like to only show the city boundary as long as the image. 

In this case, you can either set layer transparency or polygon fill color as ‘none’.  

To do so, please right-click on the polygon layer (waterloo_city) and select Properties first (Figure 9). 

Then please switch to the tab Symbology and click on the symbol itself (Figure 14). 

 

Figure 14. Properties of Symbology 

When the pop-up window shows (Figure 15), you can change the Fill Color to No Color and increase the 

Outline Width (0.4 point is somewhat narrow).  

 

Figure 15. Make Hallow Polygons 

Symbology Tab 

Click on the Symbol to 
Customize 

Change Fill Color to No Color 

Outline Width 
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2.2.2. Symbology and Label 

 

Symbology 

Symbology is critical in making maps, which are classified into four categories in ArcMap. Due to its 

complexity, these four categories and their normal usages will be briefly introduced in the note region 

with further reading. We will only focus on symbol customization and classification symbols, which are 

mostly used.  

Please right-click the public_schools layer and select Properties. Then switch to the Symboloy tab and 

click on the Symbol (Figure 14). The pop-up window (Figure 16) contains three main parts. In most 

cases, you will simply choose a symbol from the symbol library (other than making hallow polygons 

mentioned in 2.2.1.). Depending on the type of the feature (point, line, or polygon), the options change 

accordingly. 

You can type in school and click the search icon (magnifier) to search all symbols related to school 

representations. 

  

Figure 16. Symbology Customization Window with Explanations 

There are cases when you want to differentiate features in a layer based on some attribute. For 

instance, I want to know the type of public school (elementary or secondary), which is the top layer in 

Figure 11. Different types will be marked in colors. To do so, we should right-click on the school layer, 

Layer Transparency: 
An alternative (actually more generic) way of preventing overlaying is right-click the layer and 
select properties (Figure 9) first, and go to the Display tab. You can freely change the 
transparency as the parameter (percentage) of “Transparent” (or “Transparency” for raster 
layers). 

Professional 
Symbol Library 

Frequently-used Customization 
Options 

Advanced (Full) Options 

Search 
Keywords 



2.2. Key Options of Geospatial Data Representations 

Page 14 of 25 

select properties, and go to the symbology tab, which is the same as shown in Figure 12. But, instead of 

by-default Features option, we should click and select the categories option (Figure 15). The steps to 

follow are also shown in Figure 17:  

1. Click on the Categories first and make sure the “Unique Value” is chosen; 

2. Draw down the dropbox of Value Field, and select TYPE as the classification attribute; 

3. Click on the Add All Values button to add all distinct values under the TYPE attribute into 

consideration; 

4.  (Optional) Click on the Color Ramp dropbox and select your favourite color schema. 

  

Figure 17. Classifying Features using Colors 

The result is shown in Figure 18. Please note that you can still customize individual symbol for each 

category (size, shape, etc) by double clicking corresponding class on either the left pane or the line in 

symbology window (Figure 18). The pop-up window is very similar to the window in Figure 16. Please 

choose School 1  and assign a color for each school type.   

1 
2 

3 

4 
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Figure 18. Classified Symbols and Further Customization 

Label 

The labels are an important feature of a map. By marking some property up on the map, for stance, the 

name of the marked location, labels can make your map more useful, informative, and visually 

appealing.  

To add labels to your map, please right-click on the layer that you want to add marks on (public-school) 

and select Properties (Figure 14). Then follow the steps below: 

1. Select the Labels tab and check on (off by default) “Label features in this layer”.  

2. Choose the attribute you want to display (SchoolName) on the map in the dropbox of Label 

Field (Figure 19). 

3. Change Font (7 pt size and Bold), so that it is clearly shown on the map. 

4. You can click on the Apply button to see the effect until it is satisfactory. Then click OK to save 

your setting and exit. 

Symbology Customization for 
an Individual Class 
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Figure 19. Label Setting Window 

To ensure a clear label, the option of mask can be used Symbol, which locates to the right of Font 

options as a Symbol button (Figure 19). Please click it and then click the Edit Symbol button, since label 

is a kind of symbol (text symbol) too.  Navigate to the Mask tab shown in the figure below. Change the 

option of Style to Halo and size as ‘1’ (Figure 20). 

  

Figure 20. Change Mask Option for Clearer Labels 

1 

2 

3 

4 

Mask Option 
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2.2.3. Annotations 

Annotations look like labels. The key difference is that annotation can be any text you want to add on 

the map, regardless to whether the information has been included in the geospatial data. 

For instance, if you want to add a point showing the location of the University of Waterloo, please 

follow the steps below (Please note that annotations can only be edited under the data view): 

1. Turn on the Draw toolbar. To do so, please click on the menu of Customize -> Toolbars -> Draw 

(Figure 21).  

 

Figure 21. The Way of Turning on the Draw Toolbar 

2. Add Marker. Click on  and select Marker. Then browse and point to the location you want 

to add the marker (South Campus Hall in this case) and click. A marker will be added to the 

location. 

 

Figure 22. The Draw Toolbar 

Symbology Types and Their Normal Usage: 
 Features: Mainly used when you just want to mark geographic features on a map. 
 Categories: Suit for the case when feature classification is needed. 
 Quantities: Appropriate when numbers involve, i.e., population, income, depth, etc. 
 Charts: Employed when not only quantity but also the relative importance is important as 

well. For instance, incomes from different types of consumers. 
 Multiple Attributes: Utilized when multiple criteria are involved, which main not be 

quantitative. It can be regarded as a generalized case of Charts. 
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3. Add Text. Click   and choose New Text. Click on the map, somewhere close to the marker 

you just made and type in accordingly (i.e. “University of Waterloo”). 

Result is shown in Figure 23. 

 

Figure 23. Map after Adding Labels (with Mask) and Annotations 

Some Other Types of Annotations: 
 Annotate a polygon: Sometimes you may want to annotate a polygon. The easiest way to 

do so is to choose Polygon Text. Please modify the text style (color, size, etc) and the filled 
color accordingly, which locates at the right part of the Draw Toolbar (Figure 19). 

 Annotate along the road: ArcMap also allows to you to put your annotations warp along 
the road, which looks nicer. To do so, please choose Splined Text. Then make single clicks 
along the road, which defines the display route. Type in the texts and enter. The text will 
be shown along the route you made. 
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2.3. May Layout Map Components 
Switch to Layout View to start adding map components, all components are gathered in the menu of 

Insert (Figure 24). The key ones are: 

 The title of the map (Purpose/Content); 

 The scale of the map (Measurement); 

 The North Arrow (Orientation); 

 The Legend (how to interpret the map); 

 (Optional) The reference (where you obtain the data). 

 

Figure 24. All Map Components Available 

Map titles are just a specific kind of text box with some pre-defined fonts. Hence, the usage of title and 

text are identical and intuitive: type in the content and customize the text properties. 

Add scale bar or scale text is also intuitive. The only thing that should be noted as the display unit, such 

as meters, degrees, miles, etc. You can customize it by clicking the Properties button in the Scale Bar (or 

Text) Selector, which is the pop-up window when you choose Insert -> Scale Bar (or Scale Text).  In the 

Scale and Units tab, you can choose an appropriate unit in the Division Units dropbox (Figure 25). In 

addition, you can change the font style under the Format tab as well.  

In this example, please use Scale Text with meters as unites, shown like: . 

Add North Arrow is the easiest task, which is very similar to add a scale bar. Just choose a pre-defined 

north arrow from the library shown in the left pane is ok. If your North Arrow is difficult to be 

distinguished from the background, you can add some background color, which has similar effect of 

“mask” for labels. This option normally locates in the Frame tab (Figure 26). Legend, scales, and texts all 

have similar options. 

1 cm = 75 meters
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Figure 25.The  Scale Bar (or Text) Property Window 

 

Figure 26. Change Background Color in Frame Tab 

Adding Legend is somewhat complex and deserves some explanation. When Insert -> Legend is 

selected, ArcMap will use a wizard guiding you through various options of making a legend.  

At the first step, you will be asked about which layers need legend and the order of adding legend 

(Figure 27). The left pane Map Layers displays all layers (geospatial data) available for the map. The right 

pane Legend Items shows the layers that will be added to the legend in order.  

 Add/Remove Layers: You can decide the layers to be added to the legend by clicking  to add 

or  to remove. Please remove the airphoto layer, since the band information for raster 

images is not useful (Figure 24). 

Division Unit Dropbox 

Background Color Change 

Frame Tab 
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 Change the Display Orders: The legend items will be added strictly in the order shown in the 

Legend Items pane. You can change the order by clicking a layer first (displayed in the blue bar) 

and move it up  or move it down . 

 

Figure 5. The First Step of Adding Legend 

In the following three steps (four steps in total), ArcMap will ask you about some options to display the 

legend. None of them is critical and requires customization (especially for normal users). You can just 

accept all default configuration and click next until Finish it. You will get the legend that looks like in 

Figure 28. 

 

Figure 28. An Example of Generated Legend 

It is easy to find that the name displayed in the legend is difficult to understand. For instance, users 

won’t know what “waterloo_city” means. In this case, you can modify the name in the table of content 

pane (Figure 4). To do so, you can right-click on the “waterloo-city” layer and select Properties (Figure 

14). At this time, please switch to the General tab. Then you can type the more meaningful name in the 

Layer Name: City boundary (Figure 29). You can use the same method to change “waterloo_streets” to 

“Roads”. 

 

Obscure Name 
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Figure 29. The General Tab to Change Layer Name 

Lastly, we’re going to add a citation to the map.  Click on Insert -> Text under the layout view and 

type in your citation.   

 

Figure 30. Property Window of Text in Layout View 

Type in/Modify Text Here 

Customize Layer Name 
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Export Maps 
 

When you are satisfied with everything in the map and are ready to deliver, you can export your map by 

the menu of File  -> Export Map, which will pop-up a dialog (Figure 31).  

 

Figure 6. Export Map Dialog 

You can specify the directory and file name of the map in this dialog. But, most importantly, you need to 

choose an appropriate file format by click on the Save as type dropbox. The most frequent-used formats 

are JPEG and PDF. JPEG is a popular graphic file format, which is easy to be inserted into word as a 

graph, while PDF is best used for sharing. The printed copy of PDF will be identical regardless of your 

computer (and printer) environment.  

Some Components that are also frequently added: 
 Author of the Map: Users may want to know who creates the map; 
 Date Saved (Created/Modified): The more frequent a region changes, the more important 

it is for users to know when the map is created; 
 Coordinate System: The globe is not flat, but a map is. Any kind of projection used to make 

the map distorts the reality in some way. Hence, it is critical for users to know how 
reliable their measurements on the map are, especially for pilots and navigators. 

Choose File Format Here 
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Please note that if the purpose of your map is to be shown on screen, 96 dpi resolution is good enough. 

It is especially true when you want to publish your map online, given that lower resolution maps are 

much smaller, and therefore, easier to transfer via Internet. If you need hard copies of your map, please 

make sure that the resolution is set to 300 dpi or 600 dpi. Otherwise the output map might be obscure. 

Other than export map to other file formats, you can directly print out hardcopies of your map by File -> 

Print. You can preview the result via File -> Print Preview to ensure satisfactory result. And, of course, 

you can customize page and printer setup via File -> Page and Print Setup, such as page orientation 

(portrait and landscape), page size, printer configuration (color or grey), and so on. All these operations 

are intuitive and very similar to other applications, such as Microsoft Word.  

 

 

 

 

Brief Explanation of Graphic File Formats: 
 EMF file:  Enhanced Metafile, specified for Windows, which can be regarded as an 

alternative of TIFF file. EMF is an not recommended option; 
 EPS file: Enhanced PostScript file, specified by Adobe for printer drivers. It is popular in 

open-source editors, for instance, LaTeX and TeX. But it seems to be a buggy option. Try to 
avoid it; 

 AI file: Adobe Illustrator file. A major vector graphic file format. A good choice if you work 
with Adobe products, such as Illustrator, Flash, and MacroMedia ones; 

 SVG file: Scalable Vector Graphics, an open-source vector graphic standard. It is becoming 
more and more popular and can be accepted by many vendors; 

 BMP file: BitMap file, which is a mature loss-less uncompressed raster format. The quality 
is great. But its file size tends to be huge. It can be used if you need both high-quality 
output and compatibility ; 

 PNG file: Portable Network Graphics, which is an open-source standard designed to 
replace BMP and GIF. It is a true-color loss-less raster file format. PNG file is slightly 
larger than JPEG (compressed with quality loss). And some old browsers and operating 
systems do not support PNG files; 

 TIFF file: Tagged Image File Format. A major raster graphic file format provided by 
Adobe (AI for vector). Best to be used for raster file editing on Adobe Products, such as 
Photoshop; 

 GIF file: Graphics Interchange Format. An uncompressed raster file format with 256-color 
limitation. Hence, if your map contains only a few colors (vector-based data), GIF is a 
good candidate.  
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The final map may look as one below. 

 

Created by Qian Wang in 2011 and modified by Steve Xu in 2012 
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1.0 CONCEPT AND DEFINITION OF GIS 
 
Definition of GIS according to various authors 

“A GIS is a specific information system applied to geographic data and is mainly referred 
to as a system of hardware, software and procedures designed to support the capture, 
management, manipulation, analysis, modeling and display of spatially referenced data for solving 
complex planning and management problems” (Burroughs, 1986, NCGIA, 1990) 

 
“Geographical Information System is a powerful computerized information system for 

spatial data referenced by the geographic coordinates. GIS is a set of tools for collecting, storing, 
retrieving (at will), transforming, analyzing and displaying spatial data from the real world for a 
particular purpose. It may also be elaborated as an computerized information system for spatial 
data and is designed to acquire, store, retrieve, manipulate, analyze and display these data 
according to user defined specifications” (Clarke, 1986). 

 
“GIS is an information technology which stores, analyses and displays both spatial and 

non-spatial data…. GIS is actually a technology and is not necessarily limited to the confines of a 
single, well-defined software system” (Parker, 1988) 

 
“GIS is any manual or computer based set of procedures used to store and manipulate 

geographically referenced data” (Aronoff, 1989) 
 
 

2.0 COMPONENTS OF GIS 
A GIS has the following well defined components: 
1. Computer Hardware 
2. Software 
3. Spatially/ Geographically referenced data 
4. Personnels involved 

 
Computer Hardware 
 The hardware is the important component of GIS anatomy which includes the computer 
and the peripheral devices that the users interact with directly in carrying out GIS operations. The 
present day platforms for a GIS range from low end PCs to high end Workstations with a wide 
range of system capabilities in terms of performance, memory and hard disk. Thus the hardware 
components for GIS include- 

 Processor 
 Monitor 
 Input devices like 

o Key board 
o Mouse 
o Digitizer 
o Scanner 

 Storage devices like 
o Floppy disk 
o CDs 
o Hard Disk 
o Magnetic Tapes (DAT) etc 

 Output devices like  
o Monitor 
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o Printer 
o Plotter 

Software 
 Softwares are programmes, which contain a set of instructions to be performed by 
hardwares to derive the desired outputs. The major GIS softwares include: 

 ARCINFO (developed by ESRI, USA) 
 ARCVIEW (developed by ESRI, USA) 
 AUTOCAD MAP (developed by AutoDesk Inc.) 
 MAPINFO (Mapinfo corporation) 
 SPANS (PCI Geomatics, Canada) 
 ISROGIS (India) 
 GISNIC (NIC, India) 
 GRAM++ (CSRE, IIT, Bombay) 

 
Spatially Referenced Data 
 The spatially referenced data are the data, which describe the entities and events of the real 
world in terms of their- 

 Position or Location (with respect to a known coordinate system) 
 Attributes (the spatial and non-spatial characteristics associated with them) 
 Spatial relationship with each other (Topology or Geometry) 
Every spatial entity or event has specific position or location as it pertains to some space in 

our real world. So without having knowledge regarding location, we cannot identify an entity or 
event. As for example, “Bhubaneswar” is a spatial entity, but to identify it, we must first describe 
its location in terms of geographical coordinates (i.e. Latitude and Longitude). 

Apart from its location, the Bhubaneswar also needs some other characteristic definition to 
be defined. These characteristics are called attributes. As for example, after location the name 
“Bhubaneswar” needs to be described. The attributes may be spatial or non-spatial. As for 
example, the “Area” is a spatial attribute whereas the “Name” is non-spatial attribute. 

Every spatial entity or event has a geometric relationship with other spatial entities or 
events. For better analysis of spatial data, the understanding of this relationship is necessary. This 
relationship is called “Topology”. This may include adjacency, containment and connectivity.  
 
Personnel Involved 
 A GIS is useless without the people who design, programme and maintain it, supply it 
with data, and interpret its results. 
 

3.0 DATA STRUCTURE IN GIS 
As the spatially referenced data has two components: 
 Spatial component (which describes location and geometry of the spatial feature or 

event) 
 Attribute component (which describes the characteristics of the spatial feature or 

event) 
The organization or structuring of this data can be studied under two headings: 

 Spatial data model 
There are two ways of modeling or structuring spatial component of the geographically 
referenced data: 

o Raster model 
o Vector model 

 Attribute data model 
There are three classical ways of representing attribute data: 

o Hierarchical model 
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o Network model 
o Relational model 

Raster Model 
 It is an explicit representation of spatial component of data in which a set of cells is 
located by coordinates and each cell is independently addressed with the value of an attribute. In 
other words it is the representation of spatial component of data in terms of grids or pixels. 
 
Vector Model 
 It is an implicit representation of spatial component of data in which three main 
geographical entities such as point, line, and polygon are used to describe the spatial entities or 
events. In other words in vector representation, the spatial features or events are represented in 
terms of either point or line or polygon. 

 
 
Hierarchical Model 
 Hierarchical model assumes that each part of the hierarchy can be reached using a “Key” 
that fully describes the data structure. These models are good for data retrieval, but 
disadvantageous since it leads to data redundancy which increases storage and access costs. 

COMPARISON BETWEEN RASTER AND VECTOR 
 
 
PARAMETER VECTOR   RASTER   
 
Precision  Acurate & More precise Limited by grid size 
 
 
Redundancy  Less    More(As each cell is partitioned) 
       So need encoding schemes 
 
Attributes  Linkage to DBMS  Grid represents attributes 
   relations direct   Indirect linkages to relations 
 
Complexity  High (Complex algorithms Easy to organise & process 

& processing) 
 
Outputs  High quality on plotters  Mainly printer outputs 

Cartographic quality 
 
Analysis  Spatial & attribute   Amenable to map algebra 

integration, Complexity  & easy to analyse  
is higher. 

 
Remote Sensing  Indirect (Need to convert  Direct (Analysis of images 
interface   to vector)   possible)  
 
Simulation  Complex & difficult  Simulation of new datasets  
       Possible 
 
Inputs   Digitisation or Vector  Amenable to scanning 

Conversion of scanned  or rasterization of digitised 
Outputs    vectors. 
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Network Model 
 In a network data model an entity can have multiple parents as well as multiple child 
relationship. It is very useful in cases where much more rapid linkage is required, particularly in 
data structures for graphic features where adjacent items in a map or figure need to be linked 
together even though the actual data about their coordinates may be written in very different parts 
of the database. 
 
Relational Model 
 The relational database model in its simplest form stores no pointers and has no hierarchy 
of data fields within a record. Instead, the data are stored as collection of values in the form of 
simple records, known as “Tuples”, containing an ordered set of attribute values that are grouped 
together in two dimensional tables, known as relations. Each table or relation is usually a separate 
file. The pointer structures in network models and the keys in hierarchical models are replaced by 
data redundancy in the form of identification codes that are used as unique keys to identify the 
records in each file. 

This structure of attribute data organization is very flexible which can meet the demands 
of all possible queries using rules of Boolean logic and other mathematical operations. It is also 
easy for update, retrieval, maintenance, analysis etc. 

 
 

4.0 FUNCTIONALITIES/TOOLS OF GIS 
 The GIS softwares along with other elements, offer a variety of tools or functionalities for 
performing a wide range of desired data input, storage, editing, manipulation, analysis and 
presentation related activities, which can be grouped under four major modules: 

1. Data input, modeling, storage module 
2. Data retrieval, editing, manipulation and management module 
3. Analysis module 
4. Presentation and output generation module 

 
 
Data input, modeling and storage 
 After the data is collected through different primary and secondary sources from the real 
world, they are input to the GIS system. The spatial component of the data is entered through 
various devices like: 

 Digitizer 
 Scanner 
 Mouse etc 

The attribute data is entered through the keyboard. The various data input and modeling related 
activities include: 

 Data layering 
 Digitization 
 Attribute data entry 
 Importing digital data from other formats 
 Linking of attribute data to spatial data etc 

 
Data retrieval, editing, manipulation and management 
 During the data input processes many errors exist in the database due to human biasness, 
error in source data, defects in data input devices etc. So before going for any analysis, the 
database needs to be edited and rectified properly. The data editing functionalities may include: 
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 Editing spatial data 
o Adding, deleting, copying, moving features Points, lines, polygons) 
o Rotating, Splitting and joining features 

 Editing attribute data 
As the data is collected from various sources due to non-availability of all the required and 

relevant at a single source, the data need to be standardized so that integrated analysis will be 
possible. For this various manipulation and management functionalities are applied which include: 

 Transformation of all data to a common coordinate system and map projection 
 Map joining and Edge matching of maps of adjacent areas 
 Densification and smoothening of arcs etc 

 
Analysis functions 
 The GIS offers a range of desired analysis functions to be performed on the GIS-database 
containing spatial as well as attribute component. The analysis functionalities may broadly 
include: 

 Arithmetic Operations 
o Addition, Subtraction, Multiplication, Division, Exponential, functions, 

Trigonometric functions etc 
 Geometric Operations 

o Computation of areas, distances, coordinates etc 
 Logical Operations 

o Boolean functions like And, Or, Nor, Not etc. 
o Set operations like equal to, greater than, les than, intersection, union etc 

 Statistical operations 
o Sum, maxima, minima, average, dispersion etc. 

 Search and query operations 
 Selection and Reclassification 
 Spatial integration (Overlaying) 
 Spatial proximity (Buffering)  
 Neighborhood operations (Interpolation and Surface (3-D) generation etc.) 
 Connectivity and Network operations (Optimal path allocation, Finding best route etc) 

 
Presentation and Output generation 
 For better understanding and perception, after the various analysis have been made, the 
resultant information is presented and output is derived in terms of maps, charts, diagrams, tables 
etc. “Cartography” is the science of making maps and charts. So, the maps and charts are prepared 
according to cartographic symbolization principles. 
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5.0 APPLICATIONS OF GIS
Now a day, GIS is applied

engineering, agriculture, meteorology, developmental planning, socio
studies etc. Some major application areas can be outlined as follows:

 Socio-economic/Government
o Health infrastructure planning
o Local government
o Transportation planning
o Service planning
o Urban management

 Defense agencies 
o Target site identification
o Tactical support planning
o Mobile command modeling
o Intelligence data integration

 Commerce and business
o Market share analysis
o Insurance 
o Fleet management
o Direct marketing
o Target marketing
o Retail site location

 Utilities 
o Network management
o Service provision
o Telecommunications
o Emergency Repairs

 Environmental Management
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in wide range of fields including geology, hydrogeology, 
economic studies, health 
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o Land fill site selection 
o Land cover/Landuse change analysis 
o Site suitability analysis 
o Pollution monitoring 
o Natural Hazard assessment 
o Disaster Management 
o Resource Management 
o Environmental Impact Assessment 

 

6.0 ERRORS & ACCURACY IN SPATIAL DATA 

It is important to distinguish from the start a different between accuracy and precision:  
 

1) Accuracy is the degree to which information on a map or in a digital database matches 
true or accepted values. Accuracy is an issue pertaining to the quality of data and the 
number of errors contained in a dataset or map. In discussing a GIS database, it is possible 
to consider horizontal and vertical accuracy with respect to geographic position, as well as 
attribute, conceptual, and logical accuracy. 

o The level of accuracy required for particular applications varies greatly. 
o Highly accurate data can be very difficult and costly to produce and compile. 

2) Precision refers to the level of measurement and exactness of description in a GIS 
database. Precise locational data may measure position to a fraction of a unit. Precise 
attribute information may specify the characteristics of features in great detail. It is 
important to realize, however, that precise data--no matter how carefully measured--may 
be inaccurate. Surveyors may make mistakes or data may be entered into the database 
incorrectly. 

o The level of precision required for particular applications varies greatly. 
Engineering projects such as road and utility construction require very precise 
information measured to the millimeter or tenth of an inch. Demographic analyses 
of marketing or electoral trends can often make do with less, say to the closest zip 
code or precinct boundary. 

o Highly precise data can be very difficult and costly to collect. Carefully surveyed 
locations needed by utility companies to record the locations of pumps, wires, 
pipes and transformers cost $5-20 per point to collect. 

 
High precision does not indicate high accuracy nor does high accuracy imply high precision. But 
high accuracy and high precision are both expensive. 
 
Be aware also that GIS practitioners are not always consistent in their use of these terms. 
Sometimes the terms are used almost interchangeably and this should be guarded against. 
 
Two additional terms are used as well: 

1. Data quality refers to the relative accuracy and precision of a particular GIS database. 
These facts are often documented in data quality reports. 

2. Error encompasses both the imprecision of data and its inaccuracies. 
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TYPES OF ERROR 
Positional error is often of great concern in GIS, but error can actually effect many different 
characteristics of the information stored in a database. 

1. Positional accuracy and precision. 
This applies to both horizontal and vertical positions. 
Accuracy and precision are a function of the scale at which a map (paper or digital) was 
created. The mapping standards employed by the United States Geological Survey specify 
that: 
"requirements for meeting horizontal accuracy as 90 per cent of all measurable points must 
be within 1/30th of an inch for maps at a scale of 1:20,000 or larger, and 1/50th of an inch 
for maps at scales smaller than 1:20,000." 
 
2. Attribute accuracy and precision 
The non-spatial data linked to location may also be inaccurate or imprecise. Inaccuracies 
may result from mistakes of many sorts. Non-spatial data can also vary greatly in 
precision. Precise attribute information describes phenomena in great detail. For example, 
a precise description of a person living at a particular address might include gender, age, 
income, occupation, level of education, and many other characteristics. An imprecise 
description might include just income, or just gender. 
 
3. Conceptual accuracy and precision 
GIS depend upon the abstraction and classification of real-world phenomena. The users 
determines what amount of information is used and how it is classified into appropriate 
categories. Sometimes users may use inappropriate categories or misclassify information. 
For example, classifying cities by voting behavior would probably be an ineffective way to 
study fertility patterns. Failing to classify power lines by voltage would limit the 
effectiveness of a GIS designed to manage an electric utilities infrastructure. Even if the 
correct categories are employed, data may be misclassified. A study of drainage systems 
may involve classifying streams and rivers by "order," that is where a particular drainage 
channel fits within the overall tributary network. Individual channels may be misclassified 
if tributaries are miscounted. Yet some studies might not require such a precise 
categorization of stream order at all. All they may need is the location and names of all 
stream and rivers, regardless of order. 
 
 
 
4 Logical accuracy and precision 
Information stored in a database can be employed illogically. For example, permission 
might be given to build a residential subdivision on a floodplain unless the user compares 
the proposed plat with floodplain maps. Then again, building may be possible on some 
portions of a floodplain but the user will not know unless variations in flood potential have 
also been recorded and are used in the comparison. The point is that information stored in 
a GIS database must be used and compared carefully if it is to yield useful results. GIS 
systems are typically unable to warn the user if inappropriate comparisons are being made 
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or if data are being used incorrectly. Some rules for use can be incorporated in GIS 
designed as "expert systems," but developers still need to make sure that the rules 
employed match the characteristics of the real-world phenomena they are modeling. 

 
Finally, It would be a mistake to believe that highly accurate and highly precision information is 
needed for every GIS application. The need for accuracy and precision will vary radically 
depending on the type of information coded and the level of measurement needed for a particular 
application. The user must determine what will work. Excessive accuracy and precision is not 
only costly but can cause considerable details. 
 
SOURCES OF INACCURACY AND IMPRECISION 
There are many sources of error that may affect the quality of a GIS dataset. Some are quite 
obvious, but others can be difficult to discern. Few of these will be automatically identified by the 
GIS itself. It is the user's responsibility to prevent them. Particular care should be devoted to 
checking for errors because GIS are quite capable of lulling the user into a false sense of accuracy 
and precision unwarranted by the data available. For example, smooth changes in boundaries, 
contour lines, and the stepped changes of chloropleth maps are "elegant misrepresentations" of 
reality. In fact, these features are often "vague, gradual, or fuzzy" (Burrough 1986). There is an 
inherent imprecision in cartography that begins with the projection process and its necessary 
distortion of some of the data (Koeln and others 1994), an imprecision that may continue 
throughout the GIS process. Recognition of error and importantly what level of error is tolerable 
and affordable must be acknowledged and accounted for by GIS users. 
Burrough (1986) divides sources of error into three main categories: 

1. Obvious sources of error. 
2. Errors resulting from natural variations or from original measurements. 
3. Errors arising through processing. 

Generally errors of the first two types are easier to detect than those of the third because errors 
arising through processing can be quite subtle and may be difficult to identify. Burrough further 
divided these main groups into several subcategories. 
 
1 Obvious Sources of Error 
Age of data 
Data sources may simply be to old to be useful or relevant to current GIS projects. Past collection 
standards may be unknown, non-existent, or not currently acceptable. For instance, John Wesley 
Powell's nineteenth century survey data of the Grand Canyon lacks the precision of data that can 
be developed and used today. Additionally, much of the information base may have subsequently 
changed through erosion, deposition, and other geomorphic processes. Despite the power of GIS, 
reliance on old data may unknowingly skew, bias, or negate results. 
Areal Cover 
Data on a give area may be completely lacking, or only partial levels of information may be 
available for use in a GIS project. For example, vegetation or soils maps may be incomplete at 
borders and transition zones and fail to accurately portray reality. Another example is the lack of 
remote sensing data in certain parts of the world due to almost continuous cloud cover. Uniform, 
accurate coverage may not be available and the user must decide what level of generalization is 
necessary, or whether further collection of data is required. 
Map Scale 
The ability to show detail in a map is determined by its scale. A map with a scale of 1:1000 can 
illustrate much finer points of data than a smaller scale map of 1:250000. Scale restricts type, 
quantity, and quality of data (Star and Estes 1990). One must match the appropriate scale to the 
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level of detail required in the project. Enlarging a small scale map does not increase its level of 
accuracy or detail. 
Density of Observations 
The number of observations within an area is a guide to data reliability and should be known by 
the map user. An insufficient number of observations may not provide the level of resolution 
required to adequately perform spatial analysis and determine the patterns GIS projects seek to 
resolve or define. A case in point, if the contour line interval on a map is 40 feet, resolution below 
this level is not accurately possible. Lines on a map are a generalization based on the interval of 
recorded data, thus the closer the sampling interval, the more accurate the portrayed data. 
Relevance 
Quite often the desired data regarding a site or area may not exist and "surrogate " data may have 
to be used instead. A valid relationship must exist between the surrogate and the phenomenon it is 
used to study but, even then, error may creep in because the phenomenon is not being measured 
directly. A local example of the use of surrogate data are habitat studies of the golden-cheeked 
warblers in the Hill Country. It is very costly (and disturbing to the birds) to inventory these 
habitats through direct field observation. But the warblers prefer to live in stands of old growth 
cedar Juniperus ashei. These stands can be identified from aerial photographs. The density 
of Juniperus ashei can be used as surrogate measure of the density of warbler habitat. But, of 
course, some areas of cedar may uninhabited or inhibited to a very high density. These areas will 
be missed when aerial photographs are used to tabulate habitats. 
Another example of surrogate data are electronic signals from remote sensing that are use to 
estimate vegetation cover, soil types, erosion susceptibility, and many other characteristics. The 
data is being obtained by an indirect method. Sensors on the satellite do not "see" trees, but only 
certain digital signatures typical of trees and vegetation. Sometimes these signatures are recorded 
by satellites even when trees and vegetation are not present (false positives) or not recorded when 
trees and vegetation are present (false negatives). Due to cost of gathering on site information, 
surrogate data is often substituted and the user must understand variations may occur and although 
assumptions may be valid, they may not necessarily be accurate. 
Format 
Methods of formatting digital information for transmission, storage, and processing may introduce 
error in the data. Conversion of scale, projection, changing from raster to vector format, and 
resolution size of pixels are examples of possible areas for format error. Expediency and cost 
often require data reformation to the "lowest common denominator" for transmission and use by 
multiple GIS. Multiple conversions from one format to another may create a ratchet effect similar 
to making copies of copies on a photo copy machine. Additionally, international standards for 
cartographic data transmission, storage and retrieval are not fully implemented. 
Accessibility. 
Accessibility to data is not equal. What is open and readily available in one country may be 
restricted, classified, or unobtainable in another. Prior to the break-up of the former Soviet Union, 
a common highway map that is taken for granted in this country was considered classified 
information and unobtainable to most people. Military restrictions, inter-agency rivalry, privacy 
laws, and economic factors may restrict data availability or the level of accuracy in the data. 
 
 
Cost 
Extensive and reliable data is often quite expensive to obtain or convert. Initiating new collection 
of data may be too expensive for the benefits gained in a particular GIS project and project 
managers must balance their desire for accuracy the cost of the information. True accuracy is 
expensive and may be unaffordable. 
 
2. Errors Resulting from Natural Variation or from Original Measurements. 
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Although these error sources may not be as obvious, careful checking will reveal their influence 
on the project data. 
Positional accuracy 
Positional accuracy is a measurement of the variance of map features and the true position of the 
attribute (Antenucci and others 1991, p. 102). It is dependent on the type of data being used or 
observed.. Map makers can accurately place well-defined objects and features such as roads, 
buildings, boundary lines, and discrete topographical units on maps and in digital systems, 
whereas less discrete boundaries such as vegetation or soil type may reflect the estimates of the 
cartographer. Climate, biomes, relief, soil type, drainage and other features lack sharp boundaries 
in nature and are subject to interpretation. Faulty or biased field work, map digitizing errors and 
conversion, and scanning errors can all result in inaccurate maps for GIS projects. 
Accuracy of content 
Maps must be correct and free from bias. Qualitative accuracy refers to the correct labeling and 
presence of specific features. For example, a pine forest may be incorrectly labeled as a spruce 
forest, thereby introducing error that may not be known or noticeable to the map or data user. 
Certain features may be omitted from the map or spatial database through oversight, or by design. 
Other errors in quantitative accuracy may occur from faulty instrument calibration used to 
measure specific features such as altitude, soil or water pH, or atmospheric gases. Mistakes made 
in the field or laboratory may be undetectable in the GIS project unless the user has conflicting or 
corroborating information available. 
Sources of variation in data 
Variations in data may be due to measurement error introduced by faulty observation, biased 
observers, or by mis-calibrated or inappropriate equipment. For example, one can not expect sub-
meter accuracy with a hand-held, non-differential GPS receiver. Likewise, an incorrectly 
calibrated dissolved oxygen meter would produce incorrect values of oxygen concentration in a 
stream. 
There may also be a natural variation in data being collected, a variation that may not be detected 
during collection. As an example, salinity in Texas bays and estuaries varies during the year and is 
dependent upon freshwater influx and evaporation. If one was not aware of this natural variation, 
incorrect assumptions and decisions could be made, and significant error introduced into the GIS 
project. In any case if the errors do not lead to unexpected results their detection may be 
extremely difficult. 
 
3. Errors Arising Through Processing 
Processing errors are the most difficult to detect by GIS users and must be specifically looked for 
and require knowledge of the information and the systems used to process it. These are subtle 
errors that occur in several ways, and are therefore potentially more insidious, particularly because 
they can occur in multiple sets of data being manipulated in a GIS project. 
Numerical Errors 
Different computers may not have the same capability to perform complex mathematical 
operations and may produce significantly different results for the same problem. Burrough (1990) 
cites an example in number squaring that produced 1200% difference. Computer processing errors 
occur in rounding off operations and are subject to the inherent limits of number manipulation by 
the processor. Another source of error may from faulty processors, such as the recent 
mathematical problem identified in Intel's Pentium(tm) chip. In certain calculations, the chip 
would yield the wrong answer. 
A major challenge is the accurate conversion of existing to maps to digital form (Muehrcke 1986). 
Because computers must manipulate data in a digital format, numerical errors in processing can 
lead to inaccurate results. In any case numerical processing errors are extremely difficult to detect, 
and perhaps assume a sophistication not present in most GIS workers or project managers. 
Errors in Topological Analysis 
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Logic errors may cause incorrect manipulation of data and topological analyses (Star and Estes 
1990). One must recognize that data is not uniform and is subject to variation. Overlaying 
multiple layers of maps can result in problems such as Slivers , Overshoots , and Dangles . 
Variation in accuracy between different map layers may be obscured during processing leading to 
the creation of "virtual data which may be difficult to detect from real data" (Sample 1994). 
Classification and Generalization Problems 
For the human mind to comprehend vast amounts of data it must be classified, and in some cases 
generalized, to be understandable. According to Burrough (1986, pp. 137) about seven divisions 
of data is ideal and may be retained in human short term memory. Defining class intervals is 
another problem area. For instance, defining a cause of death in males between 18-25 years old 
would probably be significantly different in a class interval of 18-40 years old. Data is most 
accurately displayed and manipulated in small multiples. Defining a reasonable multiple and 
asking the question "compared to what" is critical (Tufte 1990, pp. 67-79). Classification 
and generalization of attributes used in GIS are subject to interpolation error and may introduce 
irregularities in the data that is hard to detect. 
Digitizing and Geocoding Errors 
Processing errors occur during other phases of data manipulation such as digitizing and 
geocoding, overlay and boundary intersections, and errors from rasterizing a vector map. 
Physiological errors of the operator by involuntary muscle contractions may result in spikes, 
switchbacks, polygonal knots, and loops . Errors associated with damaged source maps, operator 
error while digitizing , and bias can be checked by comparing original maps with digitized 
versions. Other errors are more elusive. 
 
 

7.0 REMOTE SENSING 
(source : http//www.gisdevelopment.net/tutorials/tuman008.htm) 
An Introduction 
Remote Sensing is the science and art of acquiring information (spectral, spatial, temporal) about 
material objects, area, or phenomenon, without coming into physical contact with the objects, or 
area, or phenomenon under investigation. Without direct contact, some means of transferring 
information through space must be utilised. In remote sensing, information transfer is 
accomplished by use of electromagnetic radiation (EMR). EMR is a form of energy that reveals 
its presence by the observable effects it produces when it strikes the matter. EMR is considered to 
span the spectrum of wavelengths from 10-10 mm to cosmic rays up to 1010 mm, the broadcast 
wavelengths, which extend from 0.30-15 mm. 
Types 

1. In respect to the type of Energy Resources: 
Passive Remote Sensing: Makes use of sensors that detect the reflected or emitted electro-
magnetic radiation from natural sources. 

Active remote Sensing: Makes use of sensors that detect reflected responses from objects that are 
irradiated from artificially-generated energy sources, such as radar. 

2. In respect to Wavelength Regions:Remote Sensing is classified into three types in respect to the 
wavelength regions 

1. Visible and Reflective Infrared Remote Sensing. 

2. Thermal Infrared Remote Sensing. 

3. Microwave Remote Sensing. 

Some Interesting Links : 
 Remote Sensing 

An Overview of Remote Sensing 



FDP On ‘GIS & Remote Sensing” 05th October 2020 to 09th October 2020   Lecture Notes  

Dept. of Civil Engineering, Siksha ‘O’Anusandhan (Deemed to be University), Bhubaneswar 13 
 

 Remote Sensing of the Global Environment 
An Article by David J. Schneider, Michigan Technological University 

 The Concept of Remote Sensing 
Historical & Technical Perspectives of Remote Sensing 

 RS Introduction and History 
An Article from Earth Observatory, NASA 

 The philosophical underpinnings of remote sensing 
The Philosophy behind Remote Sensing can perhaps….- An Article by GDSPDS 

 GOES 3.9um Channel Tutorial 
An excellent tutorial on Thermal Remote Sensing 

Bands Used in Remote Sensing 
Emission of EMR (Electo-Magnetic Radiation) from gases is due to atoms and molecules in the 
gas. Atoms consist of a positively charged nucleus surrounded by orbiting electrons, which have 
discrete energy states. Transition of electrons from one energy state to the other leads to emission 
of radiation at discrete wavelengths. The resulting spectrum is called line spectrum. Molecules 
possess rotational and vibrational energy states. Transition between which leads to emission of 
radiation in a band spectrum. The wavelengths, which are emitted by atoms/molecules, are also 
the ones, which are absorbed by them. Emission from solids and liquids occurs when they are 
heated and results in a continuous spectrum. This is called thermal emission and it is an important 
source of EMR from the viewpoint of remote sensing. 
The Electro-Magnetic Radiation (EMR), which is reflected or emitted from an object, is the 
usual source of Remote Sensing data. However, any medium, such as gravity or magnetic fields, 
can be used in remote sensing. 
Remote Sensing Technology makes use of the wide range Electro-Magnetic Spectrum (EMS) 
from a very short wave “Gamma Ray” to a very long ‘Radio Wave’. 
Wavelength regions of electro-magnetic radiation have different names ranging from Gamma ray, 
X-ray, Ultraviolet (UV), Visible light, Infrared (IR) to Radio Wave, in order from the shorter 
wavelengths. 
The optical wavelength region, an important region for remote sensing applications, is further 
subdivided as follows: 

Name Wavelength (mm) 

Optical wavelength 0.30-15.0 

Reflective 
1.    Portion Visible 
2.    Near IR 
3.    Middle IR 

0.38-3.00 
0.38-0.72 
0.72-1.30 
1.30-3.00 

Far IR (Thermal, 
Emissive) 

7.00-15.0 

Microwave region (1mm to 1m) is another portion of EM spectrum that is frequently used to 
gather valuable remote sensing information. 
Spectral Characteristics vis-à-vis different systems. 
The sunlight transmission through the atmosphere is effected by absorption and scattering of 
atmospheric molecules and aerosols. This reduction of the sunlight’s intensity s called extinction. 
The interrelationship between energy sources and atmospheric absorption characteristics is shown 
in Figure 3 
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 Figure 3(a) shows the spectral distribution of the energy emitted by the sun (black body at 58000 
K and by earth features black body at 3000 K). These two curve represent the most common 
sources of energy used in remote sensing. 

 Figure 3(b) shows the spectral regions in which the atmosphere blocks the energy are shaded. 
Remote-sensing data acquisition is limited to the unblocked spectral regions called atmospheric 
windows. 

 Figure 3(c) shows that the spectral sensitivity range of the eye (the ‘visible’ range) coincides with 
an ‘atmospheric window’ and the peak level of energy from the sun. 

 Figure3 (d) shows the example of atmospheric transmission characteristics and notes some of the 
important ‘atmospheric windows’. An ‘atmospheric window’ is a portion of Electro-magnetic 
spectrum in which the radiation passing through the atmosphere is not significantly altered by 
reflection, or absorption, or scattered by atmospheric constituents. Some useful atmospheric 
windows are given in the table. 

The important point to note from the figures is the interaction and the interdependence between 
the primary sources of Electro-magnetic energy, the atmospheric windows through which source 
energy may be transmitted to and from the earth’s surface features, and the spectral sensitivity of 
the sensors available to detect and record the energy. One cannot select the sensors to be used in 
any given remote-sensing task arbitrarily; one must instead consider 

1. the available spectral sensitivity of the sensors, 

2. the presence or absence of atmospheric windows in the spectral range(s) in which one wishes to 
sense, and 

3. the source, magnitude, and spectral composition of the energy availabe in these ranges. 

Ultimately, however, the choice of spectral range of the sensor must be based on the manner in 
which the energy interacts with the features under investigation. 
Energy Interactions, Spectral Reflectance and Colour Readability in Satellite Imagery 
All matter is composed of atoms and molecules with particular compositions. Therefore, matter 
will emit or absorb electro-magnetic radiation on a particular wavelength with respect to the inner 
state. All matter reflects, absorbs, penetrates and emits Electro-magnetic radiation in a unique 
way. Electro-magnetic radiation through the atmosphere to and from matters on the earth’s 
surface are reflected, scattered, diffracted, refracted, absorbed, transmitted and dispersed. For 
example, the reason why a leaf looks green is that the chlorophyll absorbs blue and red spectra 
and reflects the green. The unique characteristics of matter are called spectral characteristics. 
Energy Interactions 
When electro-magnetic energy is incident on any given earth surface feature, three fundamental 
energy interactions with the feature are possible. See Figure 4 
Spectral Reflectance & Colour Readability 
Two points about the above given relationship (expressed in the form of equation) should be 
noted. 

1. The proportions of energy reflected, absorbed, and transmitted will vary for different earth 
features, depending upon their material type and conditions. These differences permit us to 
distinguish different features on an image. 

2. The wavelength dependency means that, even within a given feature type, the proportion of 
reflected, absorbed, and transmitted energy will vary at different wavelengths. 

Thus, two features may be distinguishable in one spectral range and be very different on another 
wavelength brand. Within the visible portion of the spectrum, these spectral variations result in 
the visual effect called COLOUR. For example we call blue objects ‘blue’ when they reflect 
highly in the ‘green’ spectral region, and so on. Thus the eye uses spectral variations in the 
magnitude of reflected energy to discriminate between various objects. 
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A graph of the spectral reflectance of an object as a function of wavelength is called a spectral 
reflectance curve. The configuration of spectral reflectance curves provides insight characteristics 
of an object and has a strong influence on the choice of wavelength region(s) in which remote 
sensing data are acquired for a particular application. This is illustrated in figure 5, which shows 
highly generalized spectral reflectance curves of deciduous and coniferous trees. (In the 
discussion, we use the terms deciduous and coniferous somewhat loosely, referring to broad-
leaved trees, such as Oak and Maple, as deciduous and to needle-bearing trees, such as pine and 
spruce, as coniferous.). It should be noted that the curve for each of these object types is plotted as 
a ‘ribbon’ (or ‘envelope’) of values, not as a single line. This is because spectral reflectances vary 
somewhat within a given material class. That is, the spectral reflectance of one deciduous tree 
species and another will never be identical. Nor will the spectral reflectance of trees of the same 
species ever be exactly equal. 
Figure 6 shows the typical spectral reflectance curves for three basic types of earth feature: 

 Green vegetation 

 Soil 

 Water. 

The lines in this figure represent average reflectance curves compiled by measuring large sample 
features. It should be noted how distinctive the curves are for each feature. In general, the 
configuration of these curves is an indicator of the type and condition of the features to which they 
apply. Although the reflectance of individual features will vary considerably above and below the 
average, these curves demonstrate some fundamental points concerning spectral reflectance. 
Colour Discrimination based on Wavelengths of Spectral Reflectances. 
(IRS-IA/IB LISS I and LISSII*) 

Band wavelength 
(µm) 

Principal 

1 0.45-0.52 Sensitive to sedimentation, deciduous/coniferous forest cover 
discrimination, soil vegetation differentiation 

2 0.52-0.59 Green reflectance by healthy vegetation, vegetation vigour, rock-
soil discrimination, turbidity and bathymetry in shallow waters 

3 0.62-0.68 Sensitive to chlorophyll absorption: plant species discrimination, 
differentiation of soil and geological boundary 

4 0.77-0.86 Sensitive to green biomass and moisture in vegetation, land and 
water contrast, landform/geomorphic studies. 

*Spatial Resolution of Linear imaging self scanning (LISS): LISS-I (72.5 m) and LISS-II (36.25m) 
Electro-Magnetic Remote Sensing of Earth’s Resources — Process & Elements 
Major Components of Remote Sensing Technology: 
The following are major components of Remote sensing System: 

1. Energy Source 

1. Passive System: sun, irradiance from earth’s materials; 

2. Active System: irradiance from artificially generated energy sources such as radar. 

1. Platforms:(Vehicle to carry the sensor) (truck, aircraft, space shuttle, satellite, etc.) 

2. Sensors:(Device to detect electro-magnetic radiation) (camera, scanner, etc.) 

3. Detectors: (Handling signal data) (photographic, digital, etc.) 

4. Processing:(Handling Signal data) (photographic, digital etc.) 
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5. Institutionalisation: (Organisation for execution at all stages of remote-sensing technology: 
international and national orrganisations, centres, universities, etc.). 

 
Platforms 
The vehicles or carriers for remote sensors are called the platforms. Typical platforms are 
satellites and aircraft, but they can also include radio-controlled aeroplanes, balloons kits for low 
altitude remote sensing, as well as ladder trucks or ‘cherry pickers’ for ground investigations. The 
key factor for the selection of a platform is the altitude that determines the ground resolution and 
which is also dependent on the instantaneous field of view (IFOV) of the sensor on board the 
platform. 

Salient feature of some important satellite platforms. 

Features Landsat1,2,3 Landsat 
4,5 

SPOT IRS-
IA 

IRS-IC 

Natre Sun Sys Sun Sys Sun 
Sys 

Sun 
Sys 

Sun Sys 

Altitude 
(km) 

919 705 832 904 817 

Orbital 
period 
(minutes) 

103.3 99 101 103.2 101.35 

inclination 
(degrees 

99 98.2 98.7 99 98.69 

Temporal 
resolution 
(days) 

18 16 26 22 24 

Revolutions 251 233 369 307 341 

Equatorial 
crossing 
(AM) 

09.30 09.30 10.30 10.00 10.30 

Sensors RBV,MSS MSS,TM HRV LISS-
I,LISS-
II 

LISS-
III,PAN,WIFS 
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SENSORS 

ACTIVE SENSORS 
(Detect the reflected or emitted 

electromagnetic radiation from natural 
sources.) 

PASSIVE SENSORS 
(Detect reflected responses from objects that 

are irradiated from artificially-generated 
energy sources such as radar.) 

Passive 
Non-Scanning 

  
 Non-Imaging. (They are a type of profile 

recorder, ex. Microwave Radiometer. 
Magnetic sensor.Gravimeter.Fourier 
Spectrometer. 

 Imaging. (Example of this are the cameras 
which can be: Monochrome, Natural Colour, 
Infrared etc.) 

Scanning 
  
 Imaging. Image Plane scanning.Ex. TV 

CameraSolid scanner.Object Plane 
scanning.Ex. Optical Mechanical 
ScannerMicrowave radiometer. 

Active 
Non-Scanning 

 Non-Imaging. (They are a type of profile 
recorder, ex. Microwave 
Radiometer.Microwave Altimeter.Laser 
Water Depth Meter.Laser Distance Meter. 
Scanning 

 Imaging. (It is a radar ex. Object Plane 
scanning: 

 Real Aperture Radar. 

 Synthetic Aperture Radar. 

Image Plane Scanning: 
 Passive Phased Array Radar. 

Resolution 
In general resolution is defined as the ability of an entire remote-sensing system, including lens 
antennae, display, exposure, processing, and other factors, to render a sharply defined image. 
Resolution of a remote-sensing is of different types. 

1. Spectral Resolution: of a remote sensing instrument (sensor) is determined by the band-widths of 
the Electro-magnetic radiation of the channels used. High spectral resolution, thus, is achieved by 
narrow bandwidths width, collectively, are likely to provide a more accurate spectral signature for 
discrete objects than broad bandwidth. 

2. Radiometric Resolution: is determined by the number of discrete levels into which signals may be 
divided. 

3. Spatial Resolution: in terms of the geometric properties of the imaging system, is usually 
described as the instantaneous field of view (IFOV). The IFOV is defined as the maximum angle 
of view in which a sensor can effectively detect electro-magnetic energy. 

4. Temporal Resolution: is related ot the repetitive coverage of the ground by the remote-sensing 
system. The temporal resolution of Landsat 4/5 is sixteen days. 

An Ideal Remote Sensing System 
Having introduced some basic concepts, we now have the necessary elements to conceptualize an 
ideal remote sensing system. In doing so, we can then appreciate some of the problems 
encountered in the design and application of the various real remote-sensing systems examined in 
subsequent chapters. 
The basic components of an ideal remote-sensing system are shown in figure 8. These include the 
following components. 

 A uniform energy source. This source will provide energy over all wavelengths, at a constant, 
known, high level of output, irrespective of time and place. 
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 A non-interfering atmosphere. This will be an atmosphere that will not modify the energy from 
the source in any manner, whether that energy is on its way to earth’s surface or coming from it. 
Again, ideally this will hold irrespective of wavelength, time, place, and sensing altitude involved. 

 A series of unique energy/matter interaction at the earth’s surface. These interactions will generate 
reflected and/or emitted signals that are not only selective in respect to wavelengths, but also are 
known, invariant, and unique to each and every earth surface feature type and subtype of interest. 

 A super sensor. This will be a sensor, highly sensitive to all wavelengths, yielding spatially 
detailed data on the absolute brightness (or radiance) from a scene (a function of wavelength), 
throughout the spectrum. This super sensor will be simple and reliable, require, virtually no power 
or space, and be accurate and economical to operate. 

 A real-time data handling system. In this system, the instant the radiance versus wavelength 
response over a terrain element is generated, it will be processed into an interpretable format and 
recognized as being unique to the particular terrain element from which it comes. This processing 
will be performed nearly instantaneously (real time), providing timely information. Because of the 
consistent nature of the energy/matter interactions, there will be no need for reference data in the 
analytical procedure. The derived data will provide insight into the physical-chemical-biological 
state of each feature of interest. 

 Multiple data users. These people will have comprehensive knowledge of both their respective 
disciplines and of remote-sensing data acquisition and analysis techniques. The same set of data 
will become various forms of information for different users, because of their vast knowledge 
about the particular earth resources being used. 

Unfortunately, an ideal remote-sensing system, as described above, does not exist. Real remote-
sensing systems fall short of the ideal at virtually every point in the sequence outlined. 
Remote Sensing Satellites 
A satellite with remote sensors to observe the earth is called a remote-sensing satellite, or earth 
observation satellite. Remote-Sensing Satellites are characterised by their altitude, orbit and 
sensor. 
TRIOS Series (1960-1965) 
The Television and Infrared Observation Satelites. 
NOAA It is the first generation of National Oceanic and Atmospheric Administration satellites 
and was as the first operation operational remote sensing satellite system. 
The third generation NOAA satellites are also successfully used for vegetation monitoring, apart 
from meteorological monitoring. It is equipped with Advanced Very High Resolution Radiometer 
(AVHRR) sensors, and is established at an altitude of 850 km. In polar orbit. 
GMS Geo-synchronous meteorological satellite. It is established at an altitude of 36,000 km, and 
its main purpose is meteorological observations 
Landsat is established at an altitude of 700 Kms is a polar orbit and is used mainly for land area 
observation. 
Other remote sensing satellite series in operations are: SPOT, MOS, JERS, ESR, RADARSAT, 
IRS etc. 
Some Interesting Links : 
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8.0 FCC 
False color (or false colour) refers to a group of color rendering methods used to display images 
in color which were recorded in the visible or non-visible parts of theelectromagnetic spectrum. 
A false-color image is an image that depicts an object in colors that differ from those 
a photograph (a "true-color" image) would show. 

In addition, variants of false color such as pseudocolor (see discussion), density slicing (see 
discussion), and choropleths (see discussion) are used for information visualization of either data 
gathered by a single grayscale channel or data not depicting parts of the electromagnetic spectrum 
(e.g. elevation in relief maps or tissue types inmagnetic resonance imaging). 

 
 
Keys of Satellite Image Interpretation 
 
Recognizing targets is the key to interpretation and information extraction. Observing the 
differences between targets and their backgrounds involves comparing different targets based on 
any, or all, of the visual elements of tone, shape, size, pattern, texture, shadow, and 
association. Visual interpretation using these elements is often a part of our daily lives, whether 
we are conscious of it or not. Examining satellite images on the weather report, or following high 
speed chases by views from a helicopter are all familiar examples of visual image interpretation. 
Identifying targets in remotely sensed images based on these visual elements allows us to further 
interpret and analyze. The nature of each of these interpretation elements is described below, 
along with an image example of each. 
 

 

 

Tone refers to the relative brightness or colour of objects in an image. Generally, tone is the 
fundamental element for distinguishing between different targets or features. Variations in 
tone also allows the elements of shape, texture, and pattern of objects to be distinguished. 
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Shape refers to the general form, structure, or outline of individual objects. Shape can be a 
very distinctive clue for interpretation. Straight edge shapes typically represent urban or 
agricultural (field) targets, while natural features, such as forest edges, are generally more 
irregular in shape, except where man has created a road or clear cuts. Farm or crop land 
irrigated by rotating sprinkler systems would appear as circular shapes. 

 

Size of objects in an image is a function of scale. It is important to assess the size of a target 
relative to other objects in a scene, as well as the absolute size, to aid in the interpretation of 
that target. A quick approximation of target size can direct interpretation to an appropriate 
result more quickly. For example, if an interpreter had to distinguish zones of land use, and 
had identified an area with a number of buildings in it, large buildings such as factories or 
warehouses would suggest commercial property, whereas small buildings would indicate 
residential use. 

 

Pattern refers to the spatial arrangement of visibly discernible objects. Typically an orderly 
repetition of similar tones and textures will produce a distinctive and ultimately recognizable 
pattern. Orchards with evenly spaced trees, and urban streets with regularly spaced houses are 
good examples of pattern. 
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Texture refers to the arrangement and frequency of tonal variation in particular areas of an 
image. Rough textures would consist of a mottled tone where the grey levels change abruptly 
in a small area, whereas smooth textures would have very little tonal variation. Smooth 
textures are most often the result of uniform, even surfaces, such as fields, asphalt, or 
grasslands. A target with a rough surface and irregular structure, such as a forest canopy, 
results in a rough textured appearance. Texture is one of the most important elements for 
distinguishing features in radar imagery. 

 

Shadow is also helpful in interpretation as it may provide an idea of the profile and relative 
height of a target or targets which may make identification easier. However, shadows can also 
reduce or eliminate interpretation in their area of influence, since targets within shadows are 
much less (or not at all) discernible from their surroundings. Shadow is also useful for 
enhancing or identifying topography and landforms, particularly in radar imagery. 

 

Association takes into account the relationship between other recognizable objects or features 
in proximity to the target of interest. The identification of features that one would expect to 
associate with other features may provide information to facilitate identification. In the 
example given above, commercial properties may be associated with proximity to major 
transportation routes, whereas residential areas would be associated with schools, 
playgrounds, and sports fields. In our example, a lake is associated with boats, a marina, and 
adjacent recreational land. 
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9.0 HANDS ON IN QGIS 
 
Georeferencing 
- Open QGIS 
- Go to Layer Menu 
- Add Raster Layer 
- Open Odisha.jpg file provided to you 
- Now Odisha raster image will be displayed in view area 
- Then Go to Raster Menu 
- Select Georeferencer 
- A new Georeferencer Window will open 
- In this window, Go to Open Raster (top left most button) 
- The Odisha map (raster will be added to this window) 
- Go to Add GCP point button 
- Then add GCP points at the known coordinate locations on this Odisha map and input the 
longitude (X) and latitude (Y) values for at least four such known locations 
- Once done with, then Click on Start Georeferencing Button on the top 2nd left in button bar 
- A Dialog Box will appear and enter the output raster file (Odisha_Geo) name and click OK 
- The output Georeferenced raster map of Odisha i.e. Odisha_Geo.jpg will be added to view 
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Sl Place Longitude Lattitude Distance from 
Bhubaneswar

1 Bhubaneswar

2 Sambalpur

3 Raurkela

6 Puri

7 Baleswar

-Start Georeferencing of Odisha Map
-In the Georeferenced Odisha Map, Find the coordinates of Bhubaneswar, 
Sambalpur, Raurkela, Puri, Baleswar
- Find the distances of all other places from Bhubaneswar and prepare a table.

-Put the Coordinates on Google Earth and Check these locations.
-Take a screenshot/clipping of Google map with these Points.
-Send the google map and the table to the email id: 

lusinayak28591@gmail.com
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Distance Measurement 
 
- Open QGIS 
- Go to Layer Menu 
- Add Raster Layer 
- Open Odisha.jpg file provided to you 
- Now Odisha raster image will be displayed in view area 
- Then Go to Toolbar 
- Select Measurement Toolbar 
- Choose what you want a measure: a distance (Measure Line), a surface area (Measure Area) or    
an angel (Measure Angle). The Measure window will open 
- Put your Cursor in the map image and click on the starting point 
- Draw a line: left Clicking will create a node and right clicking will mark the end point. At Area    
you can create a multiple angled shape. In the measure window you can read the distance. 
Click on close in the Measure window (otherwise the line, area or angle will stay in the map 
image 
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Point Layer Creation for Towns on Odisha Map 

- Open QGIS 

- Go to Layer Menu 

- Select Layer > New > New Shape file Layer to create the new empty layer for your   
vector feature 

- You will be prompted to confirm the Coordinate Reference System for the layer. By 
default, the Coordinate Reference System for the project is used 

-Click on the Capture Points button  

-Click points at your chosen location, and choose a name for each point feature 

-Click on Toggle editing to save the vector point layer 

 

 

 The Type of feature you are tracing - point, line or polygon 

 The Name of the Attribute you are tracing 

 The Type of the Attribute - eg. Text, Whole Number 

 The Width of the field for the Attribute. Select Add to Attribute list 

 The Shapefile Name to save the layer as 

 

 

 
 
Point Layer Creation from Excel file of Coordinates of Participants 
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- Open Excel File 
- Go to office Button 
- Then Save as your File Format in Text (Tab Delimited) > Then Save  
- Open QGIS 
- Go to Layer Menu > Add Layer > Add Delimited Text Layer > Then Browse > Add Your Text 
Layer 
- Then File Format Select In (Custom delimiters) 
-“X” field is Longitude and “Y” Field is Latitude > Then OK. 
 
 

 
 
 
 
Map Layout Composition 
 
- Open QGIS 
- Go to Project Menu 
- Then Select “New Print Composer” > Add Composer title > Then OK 
- Select Your Layout Menu > Add Map  
- Once the Add Map button is active, hold the left mouse button and drag a rectangle where you 
want to insert the map. 
- Let us adjust the zoom level for the given map. Click on the Item Properties tab and enter 
15000000 for Scale value. 
- Add Label > Enter Your Title Name 
-Add Image > Click on Item Properties tab and enter Search directories > Select your North 
Arrow > Then Add 
- Then Add Scale bar 
- Add Legend 
- Then Go to Composer Menu > Export as Image 
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Photogrammetry 

 The method of determining the shapes, sizes 

and position of objects using photographs. 

 

 based on the possibility of optically 

projecting the terrain onto a flat surface 



Use of photogrammetry 

 Determining spatial information 
 Distance 

 Elevation 

 Area 

 Volume 

 Cross -section 

 

 Construction of topographical map 

 



Two types photogrammetry 

 Aerial: photograph taken from air 

 

 

 Terrestrial: photograph taken on or 

near the ground 



Two types of photographs 

Photo plane

     Vertical

Camera Axis

Photo plane

Camera Axis

     Vertical

Vertical Photograph
Oblique Photograph



Vertical photograph 



Oblique photograph 



 

Advantage of aerial photograph 

 Speed of coverage of an area 

 Ease of obtaining topography in 

inaccessible area 

 Freedom from possible omission of data in 

the field 

 The tremendous amount of detail shown 



History of photogrammetry 

 1851 --- produced the first camera 

 1858 --- aerial photograph began from 

balloons and measurement on photographs 

 1875 – produced the first aerial camera 

 1888 --- ground photography began 

 1901 --- introduced stereoscopic  principle 

of measurement 

 World War II gave rise to a new 

development of aerial photographs 

 



What information can I find on an air photo? 



What information ……. 



Aerial Photogrammetry 



Definition of technical terms 

 Exposure (or Air) Station (O) is a point in the air occupied by the front nodal 
point of the camera lens at instant of exposure. 

 

 Perspective projection: a projection is said to be perspective when the 
straight rays radiate from the common or selected point and pass thorough 
points on the sphere to the plane of projection.  

 

 Perspective Center (O): the real or imaginary point of the origin of bundles 
of perspective rays is known as perspective center. 

 

 Flying height (H): is the elevation of the exposure station O above mean sea 
level. 

 

 Line of flight: a line which represents the track of an aircraft on an existing 
map 

 



Technical terms in Figure 



 Focal Length (f): The distance from the front nodal point of the 
lens to the plane of the photograph 

 

 Principal point (p and P): principal point is a point where a 
perpendicular dropped from the front nodal point of the camera 
lens strikes the photograph.  

 

 Nadir point (plumb point)(ν or V) : The point where a plumb 
line dropped from the front nodal point, strikes the photograph  

 

 Principal line (νp) : is the line of intersection of the principal 
plane with the plane of photograph.  

 

 



 Tilt (t): Tilt is the angle νOp which the optical axis makes with 
the plumb line.  

  

 Tilted photograph : At the time of exposure if the camera axis 
(or optical axis) is tilted intentionally from the plumb line by a 
small amount usually less than 3° 

 

 Isocenter (i): is the point i in which the bisector Oi of the angle 
of tilt meets the photograph.  

 

 Swing(s): The horizontal angle measured clockwise in the plane 
of the photograph from the positive y-axis to the plumb point is 
known as the swing. 

 
 



 Azimuth of the principal plane (∝) : is the 
clockwise horizontal angle ∝ measured about the 
ground-nadir point from the ground survey north 
meridian to the principal plane of the photograph. 

 

 Horizon Point (h): the point of intersection of the 
principal line vip produced with the horizontal line 
Oh through the exposure station O, is known as the 
horizon point. 

  

 



Scale of a vertical photograph—flat area 



Image Displacement 

h

B

C

O

p, v c b

f

H

E

P, V

Datum



Mirror Stereoscope 



Stereoscopic Vision 

 Overlapping photographs  3D view 



The impression of depth is caused by: 

 Relative apparent size of near and far 

objects 

 

 Effects of light and shade 

 

 Viewing of an object simultaneously by two 

eyes which is separated in space  

principle of stereoscopic vision 



Parallax 

 The algebraic difference of the distances of 

two images of a ground point from their 

perspective principal point, measured parallel 

to the air base.  

 

 
 Parallax heighting is the process of finding the 

height of objects from stereo-pair of 

photographs that have no tilt and are taken 

from the same flying height.  

 

 



Determination of height of object 

B

f

H

hx

hy

Y

X

O O1

QD  CA BPD'C'

Datum

fig. a

P Q'
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a

b  c
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b
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d

P Q' P' Q
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 The parallax of X has magnitude of PB – (-

CQ) when distances are measured positive to 

the right. Parallax of Y is PA – (-DQ). 

 



If hy = 0, Py = bm 



Flight Planning 
 In order to obtain stereo pairs, every part of the ground to be 

surveyed must be photographed at least twice. 



Flight lines 



Over lap and side lap 



Air Base 



Photograph Required 

 Lp = length of the photograph in cms in the direction of flight 

 Lg = Net ground distance corresponding to Lp 

 Wp = width of photograph in cms at right angles to the direction 
of flight 

 Wg = Net ground distance corresponding to Wp 

 OL = %longitudinal overlap  

 Ow = % of side overlap  

 S = scale of photograph 

 Ap = Net area of the ground in each photograph 

 Ag = Total area land to be photographed 

 N = Numbers of photographs required  

 



Overlaps Formula 



Total Number of photograph 



 

Example 1: In pair of overlapping vertical photographs the mean distances 

between two principal points lying on the datum is 6.385 cm. the flying height of 

the aircraft at the time of photography, was 580 m above datum. Determine the 

difference of parallel for top and bottom of a tower of height 115 m having base 

in the datum surface. The focal length of the camera is 150 mm. 

Solution: 

 

B = (b/f)H = (6.385X580/15) = 246.89 m 

Parallax is given by : 

P = (Bf)/(H – h)  

For the bottom of the tower, h = 0. Hence 

PT = (246.89x150/(580-115) = 79.64 mm 

PB = (246.89x150/580) = 63.85 mm 

The difference of parallax is given by 

p = PT – PB = 79.64 – 63.85 = 15.79 mm 

 

The result can be checked  

h = hT – hB = (H p)/(bm + p) 

                         = (580x15.79)/(63.85 + 15.79) = 115 m ( the given value) 

 



 

Example 2: An area 40 km in the north-south direction and 36 km in the east-

west direction, it to be photogrammetrically surveyed. For this, aerial 

photography is to be made with the following data: 

i) Photograph size    = 20 cm x 20 cm 

ii) Average scale of photographs  = 1:15000 

iii) Averaged elevation of the terrain (h) = 450 m 

iv) End lap     = 60% 

v) Side lap     = 30% 

vi) Ground speed of the aircraft   = 220km/hr 

vii) Focal length of the camera   = 30 cm 

 

Calculate the following data: 

a) Flying height of the aircraft 

b) Number of photographs in each flight (i.e. strip) 

c) Number of flights (i.e. strips) 

d) Total Number of photographs 

e) Spacing of flight lines 

f) Ground distance between exposures 

g) Exposure interval 

 



Solution  

Given that 

 S = 1/15000 

 f = 30 cm 

 Lp = 20 cm 

 Wp = 20 cm 

 Lo = 40 km 

 Wo = 36 km 

 H = 450 m 

 E = 60% 

 S = 30% 



a) S =  f/(H – h)  H = (f/S) + h = 4950 m 

b) Number of photograph for each flight / Strip 

    N 1 = (Lo/L) + 1 

    L = Lp(1-E)/S = 20(1-0.6)x15000/100 = 1200 m 

    N1 =(40x1000/1200) + 1 = 34.3 = 35 

c) Number of flights or strips  

 N 2 = (Wo/W) + 1 

     W = Lp(1-Side lap)/S = 20(1-0.3)x15000/100 = 2100 m 

     N2 =(30x1000/2100) + 1 = 18.1 = 19 

d) Total number of photographs  

     N = N 1 x N2 = 35x19 = 665 

e) Spacing between flights d = (Wo/(N2-1)) = 2000 m 

f) Ground distance between exposure is L = 1200 m 

g) Exposure interval  

    t = L/V = (1200x3600/(220x1000)) = 19.6 sec 
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